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Chapter 1: Catalog Basics
What is a Catalog
An Impromptu catalog acts as a bridge to the database. The catalog points to data and insulates
Impromptu users from the complexities of the database, by letting them focus on analyzing the
data that drives their business. You must create a catalog before you or any Impromptu users
can create Impromptu reports.
Impromptu catalogs contain information that Impromptu needs to access and retrieve data from
a database. Catalogs store metadata associated with the database structure including the
• name and location of the database
• names of the columns in the selected tables
• join relationships between tables
In addition, a catalog contains folders, conditions, and calculations that you design and create.
The folders, conditions, and calculations that you define in your catalog provide report users
with a logical view of the physical data (in the database) that the catalog accesses.
As an administrator, you can create four types of catalogs:
• personal
• distributed
• shared
• secured

What You Can Do
As the creator of a catalog, you can
• change the names or locations of the folders
• select the tables to include in the catalog
• change and define the join relationships between the tables in your catalog
• generate content overview reports

What is a Personal Catalog?
A personal catalog is a catalog that you do not intend to make accessible to other Impromptu
users. You can create personal catalogs to access databases from which you require personal
reports. Personal catalogs are for individual use only and there are no security considerations.
Only the creator of the catalog can access the data referenced by the catalog.

What is a Distributed Catalog?
A distributed catalog consists of an original master distributed catalog that the administrator
controls and maintains, and one or more local catalogs (personal distributed catalogs) that are
created when users open the master distributed catalog. Distributed catalogs are useful to
maintain a certain level of control over the catalog, but allow catalog users to create their own
local copies of the catalog. Once users have created their own personal distributed catalog, they
can modify it to meet their own specific reporting needs.
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You can enable your users to modify their personal distributed catalogs by assigning them
privileges to modify folder structures and add conditions and calculations. With a distributed
catalog, you can enable the Folders and User Profiles commands so that your users can
• organize the contents of their personal distributed catalog by creating new folders
• create conditions and calculations to store in their catalog
• disconnect from the LAN and continue to work with their personal distributed catalog
• connect and disconnect from the database
• create user classes, set passwords, and control the user environment
• manage the impact on the network and database
Impromptu maintains a link with the master distributed catalog and automatically updates the
linked personal distributed catalogs with changes to the master. This enables users to change
the contents of their personal distributed catalog, while ensuring that changes to the master are
applied to their personal distributed catalogs.
Note: Users cannot change the names or locations of the folders that the administrator adds to
the catalog.

What is a Shared Catalog?
A shared catalog is generally stored on a LAN to provide access for all users. When you open a
shared catalog, you are working with the same copy of the catalog as all other users.
The creator of a shared catalog can change and grant privileges to specific users that enable
them to
• organize the contents of the catalog by creating new folders, editing folders you've created,
and changing their location
• work with conditions and calculations stored in the catalog
• connect and disconnect from the database
Note: No more than 20 users can be simultaneously connected to a read-write shared catalog.
This is a limitation of Microsoft's implementation of compound files. As a workaround, you could
use a distributed catalog. However, there are situations where distributed catalogs will not work
well (for example, getting an updated copy of a large master distributed catalog with a slow
dial-up access). You could also make the shared catalog read-only as another workaround. You
may negate some user privileges if you do this. The same problem occurs for reports for the
same reason.

What is a Secured Catalog?
A secured catalog is a read-only catalog that only the Creator can change. Use secured
catalogs to deploy "canned" reports for audiences that have no need to customize their reports.
Users cannot change a secured catalog, and they cannot create or change any of the reports
based on the catalog. Users can only view, run, export, and print reports. In addition, users can
connect to and disconnect from the database.

Tip
Store a catalog on the LAN to make shared catalogs, secured catalogs, and master distributed
catalogs available to your users. Users can use Impromptu to open these catalogs from the
LAN.

Related Topics
•
•
•
•
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"Change the Catalog Type: Overview" (p. 13)
"Create a Catalog" (p. 11)
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Create a Catalog: Overview
Description
Once you create a database definition, you can create a catalog to access data from that
database. You can create the type of catalog that best meets the needs of your intended users:
personal, distributed, shared, or secured.
During catalog creation, you must add tables from the database and define the join
relationships. Impromptu automatically creates a default set of folders based on the tables that
you add from the database. You can also define Impromptu keys that provide additional
information for joining tables. Once you have done this, you must define folders, folder items,
and any calculations and conditions that you require.

Before You Begin Creating Catalogs
Before you can create a catalog, you have access to the data in the database, and you must
define a logical database so that Impromptu can access the data.
When you start building your catalog, you need to answer the following questions:
• Do you know what information you want to include in the catalog?
For example, you want to see data for a particular division of your company. You create reports
that present marketing information and access only the tables from the database containing
marketing data.
• Do you want to create a catalog that contains all the tables from the database, only selected
tables, or only certain columns within selected tables?
• Do you want Impromptu to create the joins for you automatically? Do you want to use keys
and/or same-named columns for the automatic joins? If you do not want Impromptu to
create the joins for you, do you know the joins you want to create?
• Do you know if the database containing this information can connect to Impromptu? If so,
how does it connect?

Related Topics
•
•
•
•

"Catalog Basics" (p. 9)
"Change the Catalog Type: Overview" (p. 13)
"Create a Catalog" (p. 11)
"Open a Master Distributed Catalog" (p. 12)

Create a Catalog
Steps
1. From the Catalog menu, click New.
2. In the File Name box, type a file name for the catalog.
Note: Impromptu automatically adds the extension .cat to catalog names and stores catalog
files in the same folder as your Impromptu application. Specify your own default catalog
folder using the File Locations tab (Options command, Tools menu), to override this setting.
3. In the Description box, type a description of the catalog.
Note: A catalog description is optional.
4. In the Catalog Type box, click the type of catalog you want to create: personal, distributed,
shared, or secured.
5. In the Name box, select the database the catalog will access.
Note: If the database definition does not exist, then you must create it.
• Click Databases if you want to add a new database definition, and then click OK to return to
the New Catalog dialog box. For more information, see the Database Definition Manager
online help.
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6. Select the tables you want to include in the new catalog by using one of the following
options:
• Click Select Tables and select the database tables that you want to include in the new
catalog.
• Click Include All Tables. Impromptu creates your catalog with all the database tables, builds,
default joins, and creates two user classes: Creator and User.
For more information, see "Add Tables to a Catalog" (p. 26).
7. Click OK.
8. If you are using a database that requires a user ID and password, in the Database User ID
and Database Password boxes (Catalog Login dialog box), type your user ID and password.
9. In the Joins dialog box, define any necessary table joins, and then click OK.
For more information, see "Work with Joins" (p. 35).
10. In the User Class box (Catalog Login dialog box), select the Creator user class, and then
click OK.
11. Continue to develop your catalog by
Adding Folders
Moving Folder Items
Adding Calculations and Conditions
12. If you created a distributed, shared, or secured catalog, then place the catalog in a physical
location accessible by your users.

Note
•

You should make a backup copy of the catalog after you create your catalog, and before you
change it further.

Related Topics
•
•
•
•

"Catalog Basics" (p. 9)
"Change the Catalog Type: Overview" (p. 13)
"Create a Catalog: Overview" (p. 11)
"Open a Master Distributed Catalog" (p. 12)

Open a Master Distributed Catalog
Description
All catalogs (shared, personal, distributed, and secured) can be opened and closed using the
Open and Close commands from the Catalog menu. However, the first time a user opens a
master distributed catalog, he or she must complete additional steps to create a personal
distributed catalog.
You can have only one catalog open at any one time. To open a different catalog, you must first
close the current catalog.

About Opening Master Distributed Catalogs
When any user class other than the Creator user class opens a master distributed catalog,
Impromptu makes a copy of the catalog. This copy is known as a personal distributed catalog.
Catalog users can add folders to their personal distributed catalogs and tailor them to meet their
needs. Impromptu keeps their changes and additions even when they update their personal
distributed catalog with updated information from the master distributed catalog.
Only the Creator user class can change the master distributed catalog.
Once a catalog user other than the Creator creates a personal distributed catalog, he or she can
open it at any time. By default, every time a personal distributed catalog is opened, Impromptu
automatically updates it with changes to the master distributed catalog. Catalog users can
change their default settings so that they must manually update their personal distributed
catalogs.
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Impromptu Web Reports and Distributed Catalogs
You should disconnect personal distributed catalogs used in Impromptu Web Reports from the
master distributed catalog. For more information about preparing reports for Impromptu Web
Reports, see Prepare a Report for Impromptu Web Reports in the Impromptu User online help.

Steps
1. From the Catalog menu, click Open.
2. Click the catalog and click Open.
3. From the User Class box, click the user class to which you have access.
4. If required, type your catalog password.
Note: Impromptu asks you to name your copy of the catalog.
5. In the Database User ID and Database Password boxes (Catalog Login dialog box), type
your user ID and password if you are using a database requiring a user ID and password.
6. In the File Name box, type a name for your personal distributed catalog and click OK.

Related Topics
•
•
•
•

"Catalog Basics" (p. 9)
"Change the Catalog Type: Overview" (p. 13)
"Create a Catalog" (p. 11)
"Create a Catalog: Overview" (p. 11)

Change the Catalog Type: Overview
Description
When designing catalogs, it is best to set the catalog type based on users’ reporting needs. For
example, if you’re creating a catalog for users accessing canned reports and who will never
change the reports, create a secured catalog. If you’re creating a catalog for users who want to
add their own custom folders, create a distributed catalog and set up the appropriate user
classes.
If necessary, you can change one catalog type to another by changing certain attributes within
the catalog. For example, if you’ve developed a personal catalog and later want to enable
access by other users, you can change the personal catalog into a shared or distributed catalog.

Catalog Attributes
The following table outlines the default attributes of each catalog type. You can add new user
classes and modify existing ones. Use the descriptions in this table to determine the catalog
type that meets your user's needs:
Catalog Type

Attributes

Personal

Has only the Creator user class with full
privileges. You can:
• create and edit reports
• edit folders
• add and modify user classes
• create type-in SQL reports

Shared

Has a Creator and a User user class.
The Creator user class has full privileges.
The User user class can:
• create and edit reports
• add and modify user classes
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Catalog Type

Attributes

Distributed

Has a Creator and a User user class.
The Creator user class has full privileges.
The User user class can:
• create and edit reports
• edit folders
• add and modify user classes
Only this type is designated as a Distributed
catalog in the Catalog Properties dialog box.

Secured

Has a Creator and a User user class.
The Creator user class has full privileges.
The User user class can view reports, but it
can't create reports, change reports, or make
changes to the catalog.

Notes
•

•
•

•

•

•

•

The catalogs you create usually contain a mixture of settings from the previous table. Within
a single catalog, you might create a user class that can only view read-only canned reports.
You can design other user classes that can customize folders to meet their own regional or
departmental reporting needs.
It is unusual to change a shared, distributed, or secured catalog to a personal catalog. You
can do so only by deleting all user classes other than the Creator user class.
If you change a personal catalog to any other catalog type, it is likely that it will contain only
the Creator user class (although Personal catalogs can contain multiple user classes). To
grant others access to the catalog, you must add other user classes. By default, Impromptu
adds a user class named User automatically. For more information, see "Create a User
Class" (p. 64).
If you change a shared, secured, or distributed catalog to another catalog type, you must
change the governor settings for all user classes other than the Creator. For more
information, see "Control Editing of the Catalog Structure" (p. 71) and "Control Creating and
Editing Reports" (p. 72).
To change a distributed catalog, click the Properties command from the Catalog menu, and
then click or clear the Make this a Distributed Catalog check box. This change is in addition
to any changes required for user classes.
When you change a distributed catalog into either a shared or a secured catalog, you must
inform the catalog users. Their local copies of the distributed catalog are no longer linked to
a master distributed catalog.
If you change a shared or secured catalog into a distributed catalog, inform the catalog
users, that they will be prompted to save their own local copy of the catalog.

Related Topics
•
•
•

"Catalog Basics" (p. 9)
"Create a Catalog" (p. 11)
"Create a Catalog: Overview" (p. 11)

Use Architect with Impromptu
You can use Impromptu to create and modify catalogs or you can use catalogs created in
Cognos Architect, a standard metadata application for Cognos products. You can use Architect
to assemble metadata from existing data sources, and then create a business model of your
databases for use with Impromptu, PowerPlay, and Cognos Query.
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You can create several catalogs from the same business model, each tailored to a specific
audience. You can also create user classes for each catalog and set several properties,
including
• whether the user class can create and edit reports
• the maximum number of rows the user class can retrieve
• the maximum number of database tables the user class can access
• which parts of the catalog the user class can view

Catalogs Exported from Architect
When using these catalogs, Impromptu uses Access Manager to control security. You must
decide whether these catalogs will be read-only or read-write when you export them. They are,
by default, read-only. You cannot modify the read-only catalogs in Impromptu.
To make catalogs read-write when you export them from Architect, in the Save As dialog box,
clear the Export as Read-Only check box. For more information about exporting an Impromptu
catalog, see the Architect online help.
To modify the read-write catalogs in Impromptu, the catalog namespace must have a Creator
user class and you must log on as a member of that user class.

Import Impromptu Metadata into Architect
When you import an Impromptu catalog into the Architect model, Architect uses the information
contained in the catalog to automatically create the data access model, the business model, and
a package. Architect matches the user classes of the catalog with those in Access Manager.
Information in user classes of the catalog that don't match are not imported.
To use an Architect-generated catalog, your machine must use the same namespace as the
catalog namespace. For more information about integrating Impromptu and Architect, see the
Impromptu Administrator's Guide. For more information about Architect, see the Architect
documentation.

Related Topics
•

"Use Access Manager to Control Security" (p. 67)

Security Interaction With Impromptu Web Reports
If you want users to be prompted for a database signon every time they open a catalog, do not
share an Access Manager namespace with Impromptu Web Reports. If you use the same
namespace to store security information for both Impromptu and Impromptu Web Reports, the
security information you enter for one product may have an effect on the security for the other.
For example, you don't have a database signon stored in your namespace so Access Manager
prompts you for one when you open an Impromptu catalog. Later, you run a report in Impromptu
Web Reports that uses the same catalog, and Access Manager prompts you for a database
signon again. If the option to save database signon is specified, Access Manager stores the
database signon information in your namespace. The next time you open the catalog in
Impromptu, Access Manager already has your database signon and doesn't prompt you for one.

Database Signon Differences Between Impromptu Web Reports and
Impromptu
Impromptu Web Reports and Impromptu have similar, but different, methods for determining
database signon information. When an Impromptu Web Reports report set is retrieving
database signon information from Access Manager (User option button -- Report Project view of
the Report Administrator), it will ignore any database signon information in the catalog user
profiles. Similarly, if the report set is retrieving signons from the catalog user profiles (User Class
option button -- same location), Impromptu Web Reports will ignore any signons in Access
Manager. In contrast, Impromptu will use database signon information from either Access
Manager (preferred) or catalog user profiles when the catalog does not contain a namespace.
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Chapter 2: Work with Folders and Folder Items
When you create a catalog, each table in the catalog appears as a folder containing the table's
columns. You can also store conditions, calculations, and catalog prompts in folders.
Folders enable you to organize data items logically, according to users needs, rather than based
on how tables and views are physically stored in the database. This logical rendering of
information enables report users to access information without knowing about the tables,
indexes, and joins that comprise a typical corporate database.

What You Can Do
You can modify and organize the folders and items in the folders. You can
• create new folders and show the contents of a folder
• sort folders and folder items
• copy folders and folder items and paste them in new locations
• move and remove folders and folder items
• rename folders and folder items
• generate a folder from a report

Who Can Modify and Organize Folders and Folder Items?
If the user is using a

Then the user

Catalog that they created

Can create, modify, and organize
folders and folder items in the
catalog.

Personal distributed catalog,
Can create, modify, and organize
and you have enabled the user folders and folder items in the
to use the Folders command
catalog.
The user cannot modify and organize
folders you create.
Personal distributed catalog,
and you have prevented the
user from using the Folders
command

Cannot create, modify, and organize
folders and folder items.

Shared catalog, and you have Can create, modify, and organize
enabled the user to use the
folders and folder items in the
Folders command
catalog.
Shared catalog, and you have Cannot create, modify, and organize
prevented the user from using folders.
the Folders command
Secured catalog

Cannot create, modify, or organize
folders.

Notes
•

Changes to the original folder do not affect copies of the folder.
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Tip
•

To better view long lists of folders, resize the Folders dialog box.

Related Topics
•
•
•
•
•
•
•
•

"Copy and Paste Folders" (p. 18)
"Create a New Folder" (p. 18)
"Generate a Folder from a Report" (p. 21)
"Move Folders and Items in Folders" (p. 19)
"Remove Folders and Items in Folders" (p. 20)
"Rename Folders and Items in Folders" (p. 20)
"Sort Folders and Items in Folders" (p. 21)
"Generate a Content Overview Report" (p. 22)

Create a New Folder
Description
You can reorganize the contents of your catalog by creating new folders that reflect the different
needs of your business.
Folders are an important administrative tool because they enable you to logically organize data
items based on users’ needs, rather than on how physical tables are structured in the database.

Example
There are 20 columns from different tables that you use frequently. You can place them in a new
folder called "My Favorite Columns."

Steps
1. Close any open reports.
2. From the Catalog menu, click Folders.
3. Click Folder.
4. In the Name box, type the name of the new folder, and click OK.

More Info
Note
•
•

You can show the contents of a folder at any time.
To create a new folder inside an existing one, open and select the existing folder before
clicking Folder.

Related Topics
•
•
•
•
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Copy and Paste Folders" (p. 18)
"Generate a Folder from a Report" (p. 21)
"Move Folders and Items in Folders" (p. 19)
"Remove Folders and Items in Folders" (p. 20)
"Rename Folders and Items in Folders" (p. 20)
"Sort Folders and Items in Folders" (p. 21)

Copy and Paste Folders
Description
You can copy folders and paste them in new locations. You can reorganize the contents of your
catalog to make it more intuitive.
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Steps
1. Close any open reports.
2. From the Catalog menu, click Folders.
3. To copy a folder or item in a folder, do one of the following:
•

To copy a folder, click the folder and click Copy. Click the folder that you want the copied
folder to appear above, click Paste, and then click OK.

•

To copy an item in a folder, select the item and click Copy. Click the folder into which you
want to copy the item. Click Paste, and click OK.

Note
•

Changes to the original folder do not affect copies of the folder.

Related Topics
•
•
•
•
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Create a New Folder" (p. 18)
"Generate a Folder from a Report" (p. 21)
"Move Folders and Items in Folders" (p. 19)
"Remove Folders and Items in Folders" (p. 20)
"Rename Folders and Items in Folders" (p. 20)
"Sort Folders and Items in Folders" (p. 21)

Move Folders and Items in Folders
Description
You can move folders and items to new locations that are more intuitive. To move folders or
folder items, cut and then paste them. Your reports should still work. If you copy and paste
folders or folder items and then delete the original items, your reports based on that catalog may
fail.

Steps to Move Folders
1. Close any open reports.
2. From the Catalog menu, click Folders.
3. Click the folder you want to move.
4. Click Cut.
5. Click the folder you want the folder to appear above.
6. Click Paste and click OK.

Steps to Move Items in Folders
1. Close any open reports.
2. From the Catalog menu, click Folders.
3. In the Catalog folders box, select the item you want to move, and click Cut.
4. Select the folder into which you want to move the cut item.
5. Click Paste and click OK.

Tip
•

You can control how reports are synchronized to a changed catalog. For more information,
see "Synchronize Catalog Changes to Reports" (p. 22).
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Related Topics
•
•
•
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Copy and Paste Folders" (p. 18)
"Remove Folders and Items in Folders" (p. 20)
"Rename Folders and Items in Folders" (p. 20)
"Sort Folders and Items in Folders" (p. 21)
"Synchronize Catalog Changes to Reports" (p. 22)

Remove Folders and Items in Folders
Description
You can remove folders and items in folders. Folder items can include conditions, calculations
and prompts.

Steps
1. Close any open reports
2. From the Catalog menu, click Folders.
3. Click the folder or item you want to remove.
4. Click Cut.
Note: If you remove something by mistake, click Undo to reverse the Cut command.
5. Click OK.

Tip
•

You can control how reports are synchronized to a changed catalog. For more information,
see "Synchronize Catalog Changes to Reports" (p. 22).

Related Topics
•
•
•
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Copy and Paste Folders" (p. 18)
"Move Folders and Items in Folders" (p. 19)
"Rename Folders and Items in Folders" (p. 20)
"Sort Folders and Items in Folders" (p. 21)
"Synchronize Catalog Changes to Reports" (p. 22)

Rename Folders and Items in Folders
Description
You can rename folders and items to make their names more intuitive.

Steps
1. Close any open reports.
2. From the Catalog menu, click Folders.
3. Click the folder or item you want to rename.
4. Click Edit.
5. In the Name box, type a new name or edit the current name and click OK.
6. Click OK and click OK again.

Note
•
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Renaming tables or columns can cause existing reports to fail.
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Tip
•

You can control how reports are synchronized to a changed catalog. For more information,
see "Synchronize Catalog Changes to Reports" (p. 22).

Related Topics
•
•
•
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Copy and Paste Folders" (p. 18)
"Move Folders and Items in Folders" (p. 19)
"Remove Folders and Items in Folders" (p. 20)
"Sort Folders and Items in Folders" (p. 21)
"Synchronize Catalog Changes to Reports" (p. 22)

Sort Folders and Items in Folders
Description
You can sort folders and folder items to better manage large catalogs. Folder and folder items
can be sorted in ascending or descending alphabetical order or restored to the original sort
order.

Steps
1. Close any open reports.
2. From the Catalog menu, click Folders.
3. Click a folder or folder item, then click the sort icon at the top of the Catalog Folders list box.
4. From the drop-down list, click
•

to sort the items in ascending order (a to z)

•

to sort the items in descending order (z to a)

• to restore the default sort order
When you select a folder and
•

the folder is open, Impromptu sorts only the folders and folder items immediately
beneath the selected folder. It does not sort items in any nested folders.

•

the folder is closed, Impromptu sorts the folder and folder items at the same level in the
folder hierarchy.

5. Click OK.

Related Topics
•
•
•
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Create a New Folder" (p. 18)
"Copy and Paste Folders" (p. 18)
"Move Folders and Items in Folders" (p. 19)
"Remove Folders and Items in Folders" (p. 20)
"Rename Folders and Items in Folders" (p. 20)

Generate a Folder from a Report
Description
You can generate a folder with a set of columns and conditions from a report. This is a quick way
to create and test calculations.
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Steps
1. Close any open reports.
2. From the Catalog menu, click Folders.
Note: If you want to store the new folder in a specific folder, open the folder.
3. Click Generate.
4. In the Generate Folder dialog box, click Report, and then click OK.
5. Click the report containing the columns and conditions you want, and click Open.
Note: To add more reports, repeat steps 3 to 5.
6. Click OK.

Related Topics
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Copy and Paste Folders" (p. 18)
"Create a New Folder" (p. 18)

Synchronize Catalog Changes to Reports
Description
When you open an Impromptu report using a modified or different catalog than the one the
report was created with, Impromptu attempts to update the report item references to match the
folder items. Matching occurs as follows:
• match on the unique, internal ID
• if the internal ID is not found, match on the full folder path and folder item name
Matching on the first folder item with the same name as the report item is not attempted.
It can be useful to match on the first folder item with the same name as the report item if you
reorganized the catalog folder structure and want the report to use the new references. To
enable matching in this way, you must add the Allow Lazy Path Matching=T setting to the
[Startup Options] section of the Impromptu.ini file. If you add this setting, ensure that all folder
items in your catalog have unique names.

Related Topics
•
•
•

"Move Folders and Items in Folders" (p. 19)
"Remove Folders and Items in Folders" (p. 20)
"Rename Folders and Items in Folders" (p. 20)

Generate a Content Overview Report
Description
You can generate a content overview report on the contents of the current catalog. The report is
saved as an ASCII text file.
A content overview report describes
• catalog information, such as the catalog name and location
• information about the database, such as the database's logical name, the physical name,
and the type of database
• database tables and columns
• folders in the catalog and the items in each folder
• table joins
• information about user classes, such as the name and access privileges of each user class
You can use this report to track your catalog as you create or edit it. You can also give users a
hard copy so that they can see changes to the catalog.
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Example
The following illustrates one section of a sample Content Overview Report:
Impromptu Version 7.1
Catalog Content Report
Catalog Information
Catalog Name: C:\Program
Sales Data.CAT
Description:
Sales data
Creation Date: Wednesday,
Database Information
Logical Name: OUTDOORS
Physical Name: C:\Program
Type:
DB
Database Structure
Table : BRANCH
Column : BRANCH_CD
Column : BRANCH
Table : CUSTOMER
Column : CUST_NO
Column : CUSTOMER
Column : STATUS

Files\Cognos\cer3\Samples\Impromptu\Reports\Great Outdoors
for The Great Outdoors Co.
January 15, 2003

Files\Cognos\cer3\Samples\Impromptu\Database@OEM

Steps
1. From the Catalog menu, click Content Overview.
2. In the Files box, type a name for the report.
Note: If you do not specify an extension, Impromptu automatically adds the extension .icr.
3. From the List Files of Type box, do one of the following:
•

To save a content report, click Content Report (*.icr).

•

To save a different file type, click All Files (*.*).

4. Click the drive and directory where you want to store the report.
5. Click Options, and click one of the following:
•

To include information about the table joins, click Table Join Expressions.

•

To include the tables and columns, and their associated conditions, click Tables and
Columns.

•

To include folders and folder items, including conditions and calculations, click Folder
Hierarchy.

•

To include information about user classes, click User Class Information.

6. Click OK, and then click Save.

Note
•

You can only generate a content overview report for a catalog that you created.

Tip
•

To recreate a catalog, use Catalog Automation.

Related Topics
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Catalog Basics" (p. 9)
"Create a Catalog: Overview" (p. 11)
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What is a Table?
A table in a database is a portion of the database containing one kind of information organized
into rows and columns. A catalog identifies the tables in the database that you can access using
Impromptu. A column is a vertical list containing just one kind of information.

Why Use Tables in a Catalog?
To access data from the database, you must add tables to your catalog when you create a new
catalog. You can add and remove tables from your catalog at any time.
When the database metadata changes, you can update tables in the catalog instead of
re-creating the catalog.
You can attach filters to tables or columns to filter out data before showing the report. These
filters are automatically added to the report's own filter when the report is executed.

What You Can Do
Using Impromptu, you can
• add tables and columns to an open catalog
• sort tables
• verify and update tables
• remove tables and columns to an open catalog
• limit the scope of data for the catalog
• use keys
• qualify tables
• generate default reports
• add tables to an open catalog
• add columns from a table to an open catalog
• add the same table twice to a catalog
• add a table to the catalog using the Folders command

Notes
•
•
•

You need to consider join strategy after you add a table or column to a catalog.
You cannot have any reports open when you add tables to a catalog.
Adding and removing tables and columns can cause existing reports to fail. Validate existing
reports and regenerate them to ensure they work correctly.

Tip
•

To add just the columns you want to a catalog, double-click the table to view the columns
and then add only the columns you need.
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Related Topics
•
•
•
•
•
•
•
•
•
•
•

"Add Columns to a Catalog" (p. 27)
"Add Tables to a Catalog" (p. 26)
"Add the Same Table Twice to a Catalog" (p. 28)
"Sort Tables in a Catalog" (p. 27)
"Generate Default Reports" (p. 32)
"Remove Tables and Columns" (p. 29)
"User Profiles and Privileges" (p. 63)
"Verify and Update Tables" (p. 29)
"Work with Keys" (p. 31)
"Work with Joins" (p. 35)
"Edit, Analyse, and Test Joins" (p. 43)

Add Tables to a Catalog
Description
You can add one or more tables from the active database to a catalog. You can add tables to an
existing catalog if changes to the database affect the catalog, or if your catalog requirements
change. When you add a table, a folder is automatically created.

Steps
1. From the Catalog menu, click Tables, and then click the Edit tab.
Note: If you add tables when you create a new catalog, the Tables dialog box appears
automatically.
2. In the Database Tables box, select the table or tables to add to the catalog.
3. Click Add.
4. In the Create Joins box, select one of the following options to specify how to create table
joins:
•

To open the Edit tab (Joins dialog box) where you can create the table joins, click
Manually. This is the default.

•

To join the tables using the columns that are defined as keys, click Using Key Only.

•

To join the tables using the columns that are defined as keys or the first column that is
named the same in each table, click Using Key or First Matching Column.
Note: Impromptu matches tables using keys. If one table has a key and the other table does
not, Impromptu searches for a column with the same name and data type as the key. If there
are no keys in either table, Impromptu matches columns based on the first matching name
and data type that it finds.
•

To create no table joins, click None. You can manually create them later.

5. If you are using keys, define keys for the tables.
Note: You do not need to define keys if your database has indexed columns.
6. Qualify the tables to control how tables are qualified for SQL queries, and click OK.

Tip
•
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To better display a long list of tables, resize the Tables dialog box.
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Related Topics
•
•
•
•
•
•
•
•

"Add Columns to a Catalog" (p. 27)
"Add the Same Table Twice to a Catalog" (p. 28)
"Sort Tables in a Catalog" (p. 27)
"Limit the Tables Retrieved" (p. 30)
"Qualify Tables" (p. 32)
"Remove Tables and Columns" (p. 29)
"Verify and Update Tables" (p. 29)
"Manage Tables and Columns" (p. 25)

Sort Tables in a Catalog
Description
You can sort tables to better manage large catalogs. Tables can be sorted alphabetically in
ascending or descending order or restored to the original sort order.

Steps
1. From the Catalog menu, click Tables.
2. Click a table, then click the sort icon at the top of the appropriate list box.
•

To sort the database tables, click a table in the Database Tables box.

•

To sort the catalog tables, click a table in the Catalog Tables box.

3. From the drop-down list, click
•

to sort the items in ascending order (a to z)

•

to sort the items in descending order (z to a)

•

to restore the default order

4. Click OK.

Add Columns to a Catalog
Description
You can add one or more columns from the active database to a catalog.
You can add columns
• when you create a new catalog
• to an existing catalog if changes to the database affect the catalog
• if your catalog requirements change

Steps
1. From the Catalog menu, click Tables, and then click the Edit tab.
2. In the Database Tables box, double-click the database owner and table containing the
column or columns to add.
Note: Your database may not have a database owner.
3. Select the column or columns to add to the catalog.
4. Click Add.
A folder for the table is created in the Catalog Tables box. The folder contains only the
column or columns you selected.
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5. In the Create Joins box, select one of the following options to specify how to create the table
joins.
•

To open the Edit tab (Joins dialog box) where you can create the table joins, click
Manually. This is the default.

•

To join the tables using the columns defined as key, click Using Key Only.

•

To join the tables using the columns defined as keys or the first column that is named
the same in each table, click Using Key or First Matching Key.
Note: Impromptu matches tables using columns that have been defined as keys.
If one table has a key and the other table does not, then Impromptu looks for a column with
the same name and data type as the key. If there are no keys in either table, Impromptu
matches columns with the same name and data type.
•

To create no table joins, click None. You can manually create them later.

6. If you are using keys, define keys for the tables.
Note: You do not need to define keys if your database has indexed columns.
7. Qualify the tables if you want to control how tables are qualified for SQL queries, and click
OK.

Related Topics
•
•
•

"Add Tables to a Catalog" (p. 26)
"Remove Tables and Columns" (p. 29)
"Manage Tables and Columns" (p. 25)

Add the Same Table Twice to a Catalog
Description
You can create a table alias to add a second copy of a table to the same catalog. The second
copy of the table is added with a different name.
You can create table aliases to
• relate values within a single table. For example, if all the employee data is in one table in the
database, you can find out which employee works for which manager by adding the table,
then adding an alias of the table, and finally creating a self-join between the table and alias.
• use in a filter expression. This enables you to create a view of part of the data in a table. For
example, you can create a view for managers of the Employee table by aliasing the
Employee table under the name of Managers, and then use a filter expression on the
Managers table to create the view.

Steps
1. From the Catalog menu, click Tables, and then click the Edit tab.
2. In the Database Tables box, click the table to add to the catalog.
3. Click Alias.
4. Type the alias name and click OK.
5. Click OK.

Related Topics
•
•
•
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"Remove Tables and Columns" (p. 29)
"Manage Tables and Columns" (p. 25)
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Description
If the database has changed, you can ensure that the catalog contains the most up-to-date
information by:
• Verifying that the owners, tables, and columns in the open catalog still exist in the database.
If an owner, table, or column is not in the database, you can rename or remove it from the
catalog so the catalog matches the new database information.
• Updating a table in a master distributed catalog with the most current database information.
You need to update the tables in the master distributed catalogs if the table definition in the
database changes.

Note
You cannot have any reports open when you verify or update tables.

Steps to Verify the Tables in a Catalog
1. From the Catalog menu, click Tables.
2. In the Catalog Tables box, click the table or tables to verify.
3. Click Verify.
Note: If the table or a column within the table is no longer in the database, an X appears
over the table icon.
4. Remove or rename the table or column in the table to fix the error, and click OK.
For more information, see "Remove Tables and Columns" (p. 29).

Step to Update a Table with the Current Database Information
•

From the Catalog menu, click Update Catalog.
Note: If Impromptu cannot find the source catalog, you are be prompted to locate and select
the source catalog in the Update: Source Catalog Not Found dialog box.

Related Topics
•
•
•
•

"Add Tables to a Catalog" (p. 26)
"Qualify Tables" (p. 32)
"Manage Tables and Columns" (p. 25)
"Remove Tables and Columns" (p. 29)

Remove Tables and Columns
Description
A table is a portion of the database containing a set of information systematically arranged into
rows and columns. A catalog identifies the tables in the database you can access using
Impromptu.
You remove tables and columns from an existing catalog if changes to the database affect it, or
if your catalog requirements change.

Steps to Remove a Table from a Catalog
1. From the Catalog menu, click Tables, and then click the Edit tab.
2. In the Catalog Tables box, click the table or tables to remove.
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3. Click Remove.
Note: When you click Remove, Impromptu lists the columns and governor restrictions for
the table you are removing as well as the tables that are joined to the table that you are
removing.
4. Click OK to remove the selected items, and click OK again.

Steps to Remove a Column from a Catalog
1. From the Catalog menu, click Tables, and click the Edit tab.
2. In the Catalog Tables box, double-click the database owner and the table containing the
column or columns to remove.
Note: Your database may not have a database owner.
3. In the Catalog Tables box, select the column or columns to remove.
4. Click Remove.
Note: When you click Remove, Impromptu lists the columns you are removing, their
governor restrictions, and any joins for those columns.
5. Click OK to remove the column, and click OK again.

Notes
•
•

•

You cannot have any reports open when you remove tables and columns.
When you remove a table or column, Impromptu prevents you from using invalid data by
automatically removing all associated folders, folder items, conditions, joins, and
calculations.
You should backup your catalog before removing tables and columns.

Related Topics
•
•
•
•
•

"Add Tables to a Catalog" (p. 26)
"Add Columns to a Catalog" (p. 27)
"Qualify Tables" (p. 32)
"Verify and Update Tables" (p. 29)
"Manage Tables and Columns" (p. 25)

Limit the Tables Retrieved
Description
By default, Impromptu automatically retrieves all tables, views, and synonyms in the selected
database. Your database may not have views or synonyms.
After creating a catalog, you can limit the tables retrieved particularly if you are working with a
large database containing thousands of tables or want to eliminate certain tables from a catalog.
This ensures that your catalog supports your reporting needs with worthwhile data. You can limit
the tables retrieved at any time, including when you create a catalog.

Steps
1. From the Tools menu, click Options, and then click the General tab.
2. Clear the Retrieve Database Tables When Editing Catalog Tables check box, and click OK.
3. From the Catalog menu, click Tables, and then click the Edit tab.
4. Click Retrieve Tables.
The Retrieve Database Information dialog box appears.
5. In the Database Objects box, click the tables, views, and synonyms you want to retrieve.
Your database may have user and system versions of each object type. User objects
contain the actual database information. System objects contain metadata information
about how the database is structured. You can only check objects if they are available in
your database.
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6. In the Retrieval Conditions box, click one of the following option buttons to set retrieval
conditions:
To retrieve all metadata as specified in the Type box, click Retrieve All.
To select an option from the list and type the condition in the text box, click Retrieve Data
That.
The available condition options are Starts With, Contains, Does Not Contain, Does Not Start
With, Is Greater Than, or Is Less Than.
7. Click the Case Sensitive check box to retrieve metadata matching the typed text case.
8. Click Retrieve, and click OK.
You can now add tables or columns to your catalog from the retrieved data.
Note: When you create a new catalog, the Retrieve Database Information dialog box
appears when you are selecting tables if you have turned off the retrieve database tables
option.

Related Topics
•
•
•
•

"Add Tables to a Catalog" (p. 26)
"Remove Tables and Columns" (p. 29)
"Verify and Update Tables" (p. 29)
"Manage Tables and Columns" (p. 25)

Work with Keys
Description
Impromptu keys consist of one or more columns in the tables and are often used to join tables.
Impromptu keys do not have to correspond to database keys.
Once you select tables or columns for your catalog, you can define one or more keys for each
table. If you define keys for tables, you are creating meaningful joins and you may not need to
edit the table joins later.
You can
• define keys for a table in a new or existing catalog
• change which column in a table is defined as a key
• remove a key from a table

Note
•

Removing or defining keys in Impromptu does not affect your database.

Example
You define Cust-id as the key of the Customer table because there can be only one customer
number for each customer.

Steps to Define Keys for a Table
1. From the Catalog menu, click Tables, and then click the Edit tab.
Note: If you are defining keys while creating a catalog, the Tables dialog box appears as
part of creating a catalog.
2. In the Catalog Tables box, double-click a table to open it.
3. Click the column or columns you want to define as keys.
Note: Impromptu shows a key icon next to the selected column name.
4. Double-click the table to close it.
5. Repeat steps 2 to 4 to define keys for other tables.
6. Click OK when you have defined all of the keys.
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Steps to Change or Remove the Key for a Table
1. From the Catalog menu, click Tables, and then click the Edit tab.
2. In the Edit tab (Table dialog box), do one of the following:
•

To remove a key for the table, click the column that is defined as a key, click Key and
then click OK.

•

To change a key for the table, remove the current key, then select the new column to be
defined as a key, click Key, and then click OK.
Note: Impromptu inserts a key next to the column name.

Related Topics
•

"Manage Tables and Columns" (p. 25)

Qualify Tables
Description
You can qualify tables in SQL queries to ensure your users access the correct tables.
You can use unqualified table names to control how selected tables are qualified in SQL queries.
You can qualify tables with information on database, owner, table, and column. By default, tables
are fully qualified.
You can remove the qualifiers for table names at any time.

Example
You have a catalog of sales data, containing one table called sales, that you are testing before
releasing it to your end users. You qualify the table as <test>.<yourname>.<sales>, identifying
the table as belonging to the test database and to the yourname owner. When you are ready to
release the catalog, you remove the database and owner qualifiers to identify the table only as
sales.

Steps
1. From the Catalog menu, click Tables, and then click the Qualification tab.
Note: If your database does not support qualified tables, the Qualification tab is unavailable.
This tab is enabled for only the Creator.
2. In the Catalog Tables box, click the table to qualify.
3. To add qualifiers to the table, click Qualify More.
Note: Each time you click Qualify More, another qualifier is added to the table, starting with
the lowest level available to the selected table. The levels of qualifiers from the lowest to
highest level are column (lowest level), table, owner, and database (highest level).
4. To remove qualifiers from the tables, click Qualify Less.
Note: Every time you click Qualify Less, another qualifier is removed from that table,
starting with the highest level applied to the selected table.
5. Click OK when you finish qualifying tables.

Related Topics
•

"Manage Tables and Columns" (p. 25)

Generate Default Reports
Description
You can generate default reports for selected tables, and then use the reports as the starting
point for creating custom reports.
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Steps
1. From the Catalog menu, click Generate Reports.
2. In the Tables box, click a table.
3. Click Generate.
4. If the template on which you want to base the report appears in the FastFind tab,
double-click the template.
5. Click Browse to find a template in another location.
6. Repeat steps 2 to 5 to generate a report for another table.
7. Click Close.
The report is assigned the name of the table from which it was generated, and an .imr
extension is added to the name. From the File menu, click Open to view the report.

Related Topics
•

"Manage Tables and Columns" (p. 25)
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What is a Join?
A join defines the relational links between tables in the physical database. Joins relate the data
in one table to the data in another table in the same database, enabling you to retrieve data from
more than one table at a time.
You join tables using columns in tables. The relationship between the columns is called a link. A
join can have several columns linked together.

Example
The Order table and the Order+1 table are joined using the order_no column. Within a join,
several columns can be linked together.

Why You Create Joins
Joins between tables enable you to create reports that use columns from different tables. For
example, you may want to see the purchases made by each customer, but the information about
purchases is stored in the Sales table and the information about customers is stored in the
Order table. You create joins between these two tables so you can create reports that use
columns from each of these tables.
Once you specify all the joins, all reports automatically reflect these joins—even reports created
before the joins were specified.
If you create an incorrect join, reports show unexpected or incorrect results. Correct joins ensure
that no cross-product queries are created.

When You Create Joins
When you create a catalog, Impromptu prompts you for join information. As part of the catalog
creation process, you should edit the joins to ensure they are correct.

Types of Joins You Can Create
You can create these types of joins:
Type of Join

Operator

See this description

Equi-join

= Equal

"Create an Equi-join
Manually" (p. 36)

Non-equi join

<> Not Equal To

"Create a Non-equi-join
Manually" (p. 37)

< Less Than
> Greater Than
<= Less Than or
Equal To
>= Greater Than or
Equal To
Self-join

Any of the above

"Create a Self-join
Manually" (p. 39)

Outer Join

Not applicable

"Create an Outer Join
Manually" (p. 38)
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Type of Join

Operator

See this description

Compound Join Not applicable

"Create a Compound Join
Manually" (p. 40)

Complex Join

"Create a Complex Join
Manually" (p. 41)

Not applicable

When deciding what joins to make, you might want to consider alternatives to some joins. For
example, instead of trying to manipulate joins, you might want to create more simple reports that
users can drill between, or to create sub-reports. Impromptu creates equi-joins by default when
Impromptu creates joins.

What You Can Do
You can
• create different types of joins manually—equi-joins, non-equi-joins, outer joins, self-joins,
compound joins, and complex joins. This is the default setting.
• create joins automatically when creating a catalog by using keys or the first matching
column.
• create joins automatically after a catalog has been created.
• sort joins alphabetically in ascending or descending order

Tip
•
•

To better display a long list of joins, resize the Joins dialog box.
To sort a list of joins, click a join, then click the Sort icon at the top of the list box. Select one
of the Sort commands. You can sort joins in ascending or descending alphabetical order or
you can restore the original sort order.

Related Topics
•
•
•
•

"Create Joins Automatically After a Catalog Has Been Created" (p. 42)
"Create Joins Automatically When Creating a Catalog" (p. 41)
"Edit, Analyse, and Test Joins" (p. 43)
"Manage Tables and Columns" (p. 25)

Create an Equi-join Manually
Description
An equi-join retrieves all the rows from one table that have matching rows in another table. The
value in the first column of the equi-join is equal to the value in the second column of the
equi-join.
You usually create a join as an expression when you create a complex join.

Example
You create an equi-join between a table containing sales information and a table containing
customer information. Impromptu retrieves the data from both tables and shows all the sales for
each customer.

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, click the table to which you want to add a join.
3. In the Available Tables box, click the other table in the join.
4. Click Add.
5. Decide whether you are going to create the equi-join as a diagram or expression.
6. In the View As box, click Diagram.
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7. Click the column in each table you want to link.
8. Click Add Link.
Note: If you link more than four columns in a table join, Impromptu automatically shows the
links as an expression.
9. Click OK when you have completed adding the links.

Note
•

Impromptu creates equi-joins by default when Impromptu automatically creates joins. You
can also create equi-joins manually.

Tip
•

You can create an equi-join by defining an SQL expression. Follow the same procedure as
creating an equi-join by diagram except click Definition instead of Diagram to create the join
expression using the Join Components and Join Definition boxes. Impromptu show joins as
definitions for joins with more than four columns linked together.

Related Topics
•
•
•
•
•

"Create a Compound Join Manually" (p. 40)
"Create a Non-equi-join Manually" (p. 37)
"Create a Self-join Manually" (p. 39)
"Edit, Analyse, and Test Joins" (p. 43)
"Work with Joins" (p. 35)

Create a Non-equi-join Manually
Description
A non-equi-join retrieves all the rows from one table that meet the criteria in another table. By
default, Impromptu joins these tables with an non-equi-join.
For example, for each product you can use the not equal to (<>) operator to list the active
accounts that have not purchased a product.
You usually create a join as an expression when you create a complex join.

Example
You use the greater than (>) operator to create the non-equi-join:
REP1.SALES95 > REP2.SALES95

REP1 and REP2 are aliases of the REPRESENTATIVES table. For each sales representative,
you show all other sales representatives who sell less.
This representative (REP)

Sells more than

Fred

Sue

Fred

Jim

Fred

Mark

Sue

Jim

Sue

Mark

Jim

Mark

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, click the table to which you want to add a join.
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3. In the Available Tables box, click the other table in the join.
4. Click Add.
5. Decide whether you are going to create the non-equi-join as a diagram or expression.
6. In the View As box, click Diagram.
7. Click the column in each table you want to link.
8. Click Add Link.
Note: If you link more than four columns in a table join, Impromptu automatically shows the
links as an expression.
9. From the box between the two columns, select a non-equi-join operator to make the table
join a non-equi-join, and then click OK.
Use the following operators to create non-equi joins:
<>

Not Equal To

<

Less Than

>

Greater Than

<=

Less Than or Equal To

>=

Greater Than or Equal To

Tip
•

You can create a non-equi-join by defining an SQL expression. Follow the same procedure
as creating a non-equi-join by diagram except click Definition instead of Diagram to create
the join expression using the Join Components and Join Definition boxes. Impromptu show
joins as definitions for joins with more than four columns linked together.

Related Topics
•
•
•
•
•

"Create a Compound Join Manually" (p. 40)
"Create a Self-join Manually" (p. 39)
"Create an Equi-join Manually" (p. 36)
"Edit, Analyse, and Test Joins" (p. 43)
"Work with Joins" (p. 35)

Create an Outer Join Manually
Description
An outer join retrieves rows from two or more tables even if there are no matching rows.

Example
For each customer there may not always be a sale. Sales information is stored in one table and
Customer information in another table. When Impromptu retrieves the data from both tables, it
shows the customer record even if a customer has not bought an item.

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, click the table to which you want to add a join.
3. In the Available Tables box, click the other table in the join.
4. Click Add.
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5. In the View As box, click Diagram or Definition, and do one of the following:
Goal

Action

To retrieve all records from both click both Outer Join check
tables and merge records where boxes
matches are found (a full outer
join)
To retrieve all records from the
table on the left, matched or not,
and the matching values from
the table on the right (a left outer
join)

as a diagram, click the Outer
Join check box on the left

To retrieve all records from the
table on the right, matched or
not, plus the matching values
from the table on the left (a right
outer join)

as a diagram, click the Outer
Join check box on the right

as a definition, click the Outer
Join check box on the top

as an definition, click the Outer
Join check box on the bottom

6. Click OK.

Notes
•
•

In the Access tab (Query dialog box, Report menu) of an open report, ensure that you click
the Include Missing Table Join Values (Outer Join) check box.
Outer joins can slow computer performance. For example, if Impromptu is required to assist
a database that provides less than complete support of the SQL-92 definition of outer join
processing. When dealing with outer joins, see your vendor documentation.

Related Topics
•
•
•
•

"Create a Compound Join Manually" (p. 40)
"Create a Self-join Manually" (p. 39)
"Edit, Analyse, and Test Joins" (p. 43)
"Work with Joins" (p. 35)

Create a Self-join Manually
Description
Use self-joins to add two or more references to the same table in a catalog. Use the Alias button
(Edit tab, Tables dialog box) to add multiple copies of one table to a catalog.
Once you add two or more references to the same table, you can create joins between the
tables and aliases to relate the values.
You can add equi-joins, non-equi-joins, or outer joins as a self join.
Create self-joins to see relationships between data in one database table.

Example
Your employee data is in one database table called Employees, and you want to find out which
employees work for which manager. You add the Employees table to the catalog and then alias
the Employees table to add it a second time. You call the aliased table Managers and create a
join between the Employees table and the Managers table. You create a report showing which
employees work for each manager.

Steps
1. Add a table to the catalog, and then add the same table again using an alias.
For more information, see "Add the Same Table Twice to a Catalog" (p. 28).
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2. From the Catalog menu, click Joins, and then click the Edit tab.
3. In the Join Paths box, click the table to which you want to add a join.
4. In the Available Tables box, click the table alias.
5. Click Add.
6. Create an equi-join, non-equi-join, or outer join for the tables, and click OK.
•

To create an equi-join, see "Create an Equi-join Manually" (p. 36).

•

To create a non-equi-join, see "Create a Non-equi-join Manually" (p. 37).

•

To create an outer join, see "Create an Outer Join Manually" (p. 38).

Related Topics
•
•
•

"Create a Compound Join Manually" (p. 40)
"Edit, Analyse, and Test Joins" (p. 43)
"Work with Joins" (p. 35)

Create a Compound Join Manually
Description
A compound join is a join containing several columns joining two tables. A compound join can be
an equi-join, non-equi-join, outer join, self-join, or complex join.

Example
You join the Customer table and the Outlet table by linking city and state. You type the following:
CUSTSITE.CUST_NO=ORDER.CUST_NO and CUSTSITE.SITE_NO=ORDER.SITE_NO

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, click the table to which you want to add a join.
3. In the Available Tables box, click the other table in the join.
4. Click Add.
5. In the View As box, click Definition.
6. In the Join Component box, double-click the join components to add them to the join
expression. Separate each table join with "and" or "or".
Note: In the Join Components box, double-click the Database component to add columns to
your join expression.
7. Click OK.

Note
•

You must click Definition to create a compound join using the "or" operator.

Related Topics
•
•
•
•
•
•
•
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Create a Complex Join Manually
Description
A complex join uses an expression to join two tables. You must click Definition to create a
complex join.

Example
You need to join the product code in the Sales table to product code in the Products table.
However, the product code in the Sales table is four digits long while product code in the
Products table is the same four digits plus two more digits for the branch code. You use a
complex join to link these columns.
Sales.prod_code = Substring (Products.prod_code, 1,4)

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, click the table to which you want to add a join.
3. In the Available Tables box, click the other table in the join.
4. Click Add.
5. In the View As box, click Definition.
6. In the Join Components box, double-click the join components to add them to the join
expression.
Note: In the Join Components box, double-click the Database component to add columns to
your join expression.
7. Click OK.

Note
•
•

Complex joins cannot use summary calculations. You can use only simple expressions
within a complex join.
When defining complex joins, be aware of the interaction between Impromptu and the
database. If you use internal expressions and functions those with, processing could end up
being done by Impromptu rather than the database. This could have a negative impact on
computer performance.

Related Topics
•
•
•

"Create a Compound Join Manually" (p. 40)
"Edit, Analyse, and Test Joins" (p. 43)
"Work with Joins" (p. 35)

Create Joins Automatically When Creating a Catalog
Description
When you create a catalog, you can create joins automatically using keys or the first matching
column. You can define keys in Impromptu or use the keys defined in the database.

Steps
1. From the Catalog menu, click Tables, and then click the Edit tab.
2. In the Database Tables box, click the tables to add to the catalog.
3. Click Add.
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4. In the Create Joins box, click one of the following options to specify how to create the table
joins:
•

To join tables using the keys you define, click Using Key Only.

•

To join tables using the keys you define or the first column with the same name and data
type, click Using Key or First Matching Column.
If both tables have keys defined, Impromptu joins the tables using keys. If one table has a
key, Impromptu looks for the first column with the same name and data type in the second
table. If neither table has a key, Impromptu looks for the first column in each table with the
same name and data type.
5. Define Impromptu keys for the tables if you want to use keys to join tables, and if the
columns are not indexed in the database.
See "Work with Keys" (p. 31) for more information.
6. Click OK.
7. Ensure that the joins created by Impromptu are valid.

Related Topics
•
•
•

"Create Joins Automatically After a Catalog Has Been Created" (p. 42)
"Edit, Analyse, and Test Joins" (p. 43)
"Work with Joins" (p. 35)

Create Joins Automatically After a Catalog Has Been Created
Description
You can create a catalog without defining any table joins, and then later create joins
automatically.

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, click the table to which you want to add a join.
3. In the Available Tables box, click the other table in the join.
4. Click Generate.
5. In the Create Table Joins for New Tables box, click one of the following options:
•

To join tables by the keys you define, click Using Keys Only.

•

To join tables by the keys you define or the first column with the same name and data
type, click Using Keys or the First Matching Column.
If both tables have keys defined, Impromptu joins the tables using keys. If one table has a
key, Impromptu looks for the first column with the same name and data type in the second
table. If neither table has a key, Impromptu looks for the first column in each table with the
same name and data type.
6. Click OK to accept your table join setting, and then click OK again.
Note: By default, Impromptu joins these tables with an equi-join.
7. Ensure that the joins created by Impromptu are valid.

Related Topics
•
•
•
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What You Can Do
You can edit table joins to identify which tables are joined and which columns in each table are
linked.
You can analyze table joins to identify problems in them. For example, there may be a loop in the
table joins, going from Customer to Order to Product to Customer.
You can test table joins to identify the tables Impromptu uses when creating reports. For
example, if you know a report will be created using only two of the six tables in a catalog, you
can test the table joins for those two tables.

Related Topics
•
•
•
•
•
•
•

"Analyze the Joins" (p. 43)
"Change Joins" (p. 45)
"Edit the Joins" (p. 43)
"Remove Joins" (p. 45)
"Test the Joins" (p. 44)
"Work with Joins" (p. 35)
"Manage Tables and Columns" (p. 25)

Edit the Joins
Description
You can see exactly which joins are created for each table and edit these joins.

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, click the table you want to view, and then click Show Joins.
3. In the Join Paths box, click the table joins to see how individual table columns are joined.
4. Change the table join and click OK.

Related Topics
•
•
•
•
•
•

"Analyze the Joins" (p. 43)
"Change Joins" (p. 45)
"Edit, Analyse, and Test Joins" (p. 43)
"Remove Joins" (p. 45)
"Test the Joins" (p. 44)
"Work with Joins" (p. 35)

Analyze the Joins
Description
You can see exactly which joins are created for each table and then analyze the joins.
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Steps
1. From the Catalog menu, click Joins, and then click the Analyze tab.
2. Select the table join you want to analyze.
3. You can correct found problems by doing one of the following:
•

To delete the entire table join, click Remove Join.

•

To create an alias for the table join, click Create Alias.

• To edit the table join, click Edit Join.
When you correct a problem, the next problem automatically appears. To skip a table join
problem, click Next to show the next problem. To move to the beginning, click Restart to
show the first problem.
When you have resolved all table join problems, the Exception box shows an "End of List"
message.
4. Click OK.

Related Topics
•
•
•
•
•

"Change Joins" (p. 45)
"Edit the Joins" (p. 43)
"Edit, Analyse, and Test Joins" (p. 43)
"Remove Joins" (p. 45)
"Test the Joins" (p. 44)

Test the Joins
Description
You can test the results of table joins that will be used in reports.

Example
The catalog users create a report based on two tables that are not joined. You can see the
intermediate tables Impromptu automatically uses to join these tables.

Steps
1. From the Catalog menu, click Joins, and then click the Test tab.
2. In the Available Tables box, click the tables you want to test, and then click Add.
The Join Strategy box shows the table joins, including intermediate tables Impromptu uses
to create reports based on the selected tables. Change the order in which joins are added to
the catalog to change this join strategy.
3. Select the join, and click Edit Join to edit a join.
4. Click OK.

Related Topics
•
•
•
•
•
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Change Joins
Description
You may need to change the joins if
• the tables contain columns that should not be joined
• the database changes and you need to update the joins
If you change a join, all reports use the new join. You can change the table joins at any time.
You can
• change a join as a diagram
• change a join as an expression

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, double-click the table you want to view.
3. In the Join Paths box, select the table join you want to change.
Impromptu shows the columns in each table and which columns are linked.
4. Click Diagram or Definition.
5. If you clicked Diagram, do one of the following:
•

To change the join type, select two linked columns and click a different join type.

•

To link additional columns, click two columns and click Add Link.

6. If you clicked Definition, select the part of the table join to change. In the Join Definition box,
click the join components to modify your expression.
7. Click OK.

Related Topics
•
•
•
•
•

"Analyze the Joins" (p. 43)
"Edit the Joins" (p. 43)
"Edit, Analyse, and Test Joins" (p. 43)
"Remove Joins" (p. 45)
"Test the Joins" (p. 44)

Remove Joins
Description
You can remove an entire table join or you can remove the link between two columns in a table
join.

Steps
1. From the Catalog menu, click Joins, and then click the Edit tab.
2. In the Join Paths box, select the table you want to view, and then click Show Joins.
3. In the Join Paths box, do one of the following:
•

To remove a join, select the table join in Joins Paths that you want to remove, and then
click Remove.

•

To remove a link, select the table join you want to remove. In the Diagram view, click the
Join Operator box for the columns that are linked together, and then click Remove Link.

4. To remove other table joins or links, repeat step 3.
5. Click OK.
Modifying or removing joins may change the SQL generated by existing reports. You need
to confirm the SQL.
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Related Topics
•
•
•
•
•
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Chapter 7: Work with Conditions, Calculations
and Prompts
You can store conditions, calculations, and prompts in reports or in a catalog. Storing conditions,
calculations, and prompts in a catalog saves you and your users time, because you do not have
to re-create frequently-used expressions for re-use in reports.
You can also organize your conditions, calculations, and prompts so they are easy to find. For
example, create a folder called Exception Conditions to hold all conditions that track exceptions.

What is a Condition?
A condition is a true-false expression you can include in a report to filter data. Use conditions
when you want to make frequently-used expressions available to catalog users.
For example, you can define a condition that shows only data for your sales region.

What is a Calculation?
A calculation is an expression using existing data items to calculate a new data item. For
example, you can define a calculation that gives the discounted price for a preferred customer.

What is a Prompt?
A prompt is an expression that you set up so users can filter the data in a report by typing or
picking a filter value when the report opens. Prompts help report users quickly find the
information they need.
For example, you can define a prompt that enables sales representatives to select customer
sites by city.

Related Topics
•
•
•
•

"Work with Folders and Folder Items" (p. 17)
"Work with Conditions Stored in the Catalog: Overview" (p. 47)
"Work with Calculations Stored in the Catalog" (p. 53)
"Work with Prompts" (p. 57)

Work with Conditions Stored in the Catalog: Overview
Conditions
A condition is an expression you can use when you need to compare fields or values. Store
conditions in the catalog to make frequently-used conditions available to all catalog users.

Example
You define a condition that shows data for only your sales region and then include this condition
in a catalog that your users can access.
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What You Can Do
There are many things you can do with conditions. For example, you can use conditions in
• a filter to retrieve data that falls between two dates
• a conditional format to show sales figures below quota in red.
• an if/then calculation to create a more complex calculation. For example, to convert
American prices to Canadian currency without changing the original American prices,
create this calculation:
if (Salescountrycode = 4) then (Unitsaleprice * 1.43) else (Unitsaleprice)
In this calculation, "Salescountrycode = 4" is a condition.
If your users are using a

Then your users can

Catalog that they created

Create, use, change, rename,
and remove conditions.

Personal distributed catalog or
a shared catalog and you have
enabled them to use the
Folders command

Create, change, rename, and
remove conditions.
Your users can use conditions
you create in their filters,
conditional formatting, and
calculations.
Your users cannot change,
rename, or remove conditions
that you create.

Personal distributed catalog or
a shared catalog and you have
prevented them from using the
Folders command

Can use conditions you create
in their filters, conditional
formatting, and calculations.

Secured catalog

Cannot create, use, change,
rename, or remove conditions.

Your users cannot create,
change, rename, or remove
conditions.

Related Topics
•
•
•
•
•
•

"Change a Condition Stored in the Catalog" (p. 51)
"Create a Condition Stored in the Catalog" (p. 48)
"Remove Folders and Items in Folders" (p. 20)
"Use a Stored Condition as a Filter" (p. 49)
"Use a Stored Condition in a Calculation" (p. 50)
"Work with Conditions, Calculations and Prompts" (p. 47)

Create a Condition Stored in the Catalog
Description
You can create a condition that is stored in the catalog. You, or your users, can use the stored
condition in reports either as part of a filter or on its own. For example, you create a condition
that shows data for only your sales region.
Conditions stored in the catalog save you and your users time. They eliminate the need to
re-create frequently-used expressions. As well, you control the definitions in the conditions and
calculations.
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Example
You define a condition that sets a region to consist of certain states. If another state is added to
the region, you add the new state to the condition once. All reports change to show the new
state in the region.

Steps
1. From the Catalog menu, click Folders.
2. Click Condition.
3. In the Name box, type a name for the condition.
4. Build an expression.
5. Click OK.
Note: If you select a folder, the new condition appears before the selected folder. If you do
not select a folder, the new condition appears at the end of the list.
6. Click OK.

Related Topics
•
•
•

"Change a Condition Stored in the Catalog" (p. 51)
"Remove Folders and Items in Folders" (p. 20)
"Work with Conditions, Calculations and Prompts" (p. 47)

Use a Stored Condition as a Filter
Description
You can use a stored condition as a filter in a report.

Example
You retrieve data that falls between two dates.

Steps
1. Open a report or template.
1. From the Report menu, click Query, and then click the Filter tab.
2. In the Available Components box, click Catalog Columns.
3. Select the condition you want to use and click OK.
Note: The selected condition appears in the Filter Definition box. You can use the condition
from the catalog on its own or you can add to the condition.
4. Click OK.

Related Topics
•
•
•

"Use a Stored Condition in a Calculation" (p. 50)
"Use a Stored Condition in Conditional Formatting" (p. 49)
"Work with Conditions, Calculations and Prompts" (p. 47)

Use a Stored Condition in Conditional Formatting
Description
You can use a condition stored in the catalog in conditional formatting.

Example
You show sales figures that are below quota in red.
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Steps
1. In a report or template, select one or more report objects.
2. From the Format menu, click Conditional Formats.
3. Click Conditions.
4. Click Add Catalog Condition.
5. In the Catalog Folders box, click the condition, and click OK.
6. Click Close.
7. From the Change Style To box, select the style, or create your own style, and then click OK
to associate your condition with a style.
8. Click OK.

Tip
•

To apply styles to conditions, select the condition from the Conditional Formats dialog box,
select a style from the Change Style To box, and click OK.

Related Topics
•
•
•

"Use a Stored Condition as a Filter" (p. 49)
"Use a Stored Condition in a Calculation" (p. 50)
"Work with Conditions, Calculations and Prompts" (p. 47)

Use a Stored Condition in a Calculation
Description
You can use a condition stored in the catalog in an if/then calculation.

Example
To convert prices to Canadian currency without changing the listed North American prices, you
create this calculation:
if (North_American_Customer) then (Product_Price * 1.43) else (Product_Price)

In this calculation, "North American Customer " is a condition stored in the catalog.

Steps
1. Open a report.
2. From the Report menu, click Query, and then click
•

the Data tab if you opened a list report

•

the Crosstab tab if you opened a crosstab report

3. Click the Calculation button.
Calculation button
4. In the Available Components box, double-click If and then double-click Catalog Columns.
5. Select the condition you want to use and click OK.
The selected condition appears in the Expression box. You can use the condition from the
catalog on its own or you can add to the condition.
6. Click OK.

Related Topics
•
•
•
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Change a Condition Stored in the Catalog
Description
You can change a condition stored in the catalog at any time.

Example
You define a condition that sets a region to consist of certain states. If another state is added to
the region, you add the new state to the condition once. All reports using the condition change
to show the new state in the region.

Steps
1. Close any open reports.
2. From the Catalog menu, click Folders.
3. Click the condition you want to change.
4. Click Edit.
5. Click the part of the condition you want to change.
6. Change the expression and click OK.
7. Click OK.

Related Topics
•
•
•

"Create a Condition Stored in the Catalog" (p. 48)
"Remove Folders and Items in Folders" (p. 20)
"Work with Conditions Stored in the Catalog: Overview" (p. 47)
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Catalog
What is a Calculation?
A calculation is an expression that uses existing data items to calculate a new data item. Use
calculations to summarize data or perform calculations on data.

Example
You define a calculation that calculates the discounted price for a valued customer.

Related Topics
•
•
•
•
•
•

"Change a Calculation Stored in the Catalog" (p. 55)
"Create a Calculation Stored in the Catalog" (p. 53)
"Remove Folders and Items in Folders" (p. 20)
"Store a Summary in the Catalog" (p. 54)
"Use a Calculation Stored in the Catalog" (p. 54)
"Work with Conditions, Calculations and Prompts" (p. 47)

Create a Calculation Stored in the Catalog
Description
You can create a calculation stored in the catalog. You or your users can use the calculation in
reports, either as part of another calculation or on its own. Calculations stored in the catalog
save you and your users time by eliminating the need to re-create frequently-used expressions.
As well, you control the definitions in the calculations.

Example
You define a calculation called Profit that subtracts Product Cost from Product Price for each
product.

Steps
1. From the Catalog menu, click Folders.
2. Click Calculation.
3. In the Name box, type a name for the calculation.
4. Build an expression and click OK.
5. Click OK.

Related Topics
•
•
•
•
•

"Change a Calculation Stored in the Catalog" (p. 55)
"Remove Folders and Items in Folders" (p. 20)
"Store a Summary in the Catalog" (p. 54)
"Use a Calculation Stored in the Catalog" (p. 54)
"Work with Calculations Stored in the Catalog" (p. 53)
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Store a Summary in the Catalog
Description
You can store a frequently used summary in the catalog so you do not have to re-create it in
every report. You can store only summaries that already exist in a saved report in the catalog.
To store a summary in the catalog, generate a folder based on the report containing the
summary, and then delete all data items but the summary from the folder. You need to enable
your users to use the Folders command.

Example
You routinely summarize the quantity of a product sold at the various levels of your operations.
You store a Total (Qty) summary in the catalog to use it later in any report.

Steps
1. Close all open reports.
2. From the Catalog menu, click Folders.
3. Click Generate.
4. Click Report, and click OK.
5. Click the report containing the summary you want to add to the catalog and click OK.
6. Open the new folder and click the data items you do not want to add to the catalog.
7. Click Cut, and click OK.

Related Topics
•
•
•
•
•

"Change a Calculation Stored in the Catalog" (p. 55)
"Create a Calculation Stored in the Catalog" (p. 53)
"Remove Folders and Items in Folders" (p. 20)
"Use a Calculation Stored in the Catalog" (p. 54)
"Work with Calculations Stored in the Catalog" (p. 53)

Use a Calculation Stored in the Catalog
Description
You can use a calculation that is stored in a catalog in a report. Calculations stored in the
catalog save you and your users time by eliminating the need to re-create frequently-used
expressions.

Example
You use a calculation that calculates the discounted price for a valued customer.

Steps
1. Open a report.
2. From the Report menu, click Query, and then click
•

the Data tab if you opened a list report

•

the Crosstab tab if you opened a crosstab report

3. In the Catalog box, select the calculation to use.
4. Click Add, and click OK.
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Related Topics
•
•
•
•
•

"Change a Calculation Stored in the Catalog" (p. 55)
"Create a Calculation Stored in the Catalog" (p. 53)
"Remove Folders and Items in Folders" (p. 20)
"Store a Summary in the Catalog" (p. 54)
"Work with Calculations Stored in the Catalog" (p. 53)

Change a Calculation Stored in the Catalog
Description
You can change a calculation stored in the catalog at any time. All reports that use this
calculation automatically change when you change the calculation.

Example
You define a calculation called Profit that subtracts Product Cost from Product Price for each
product. If this calculation uses the wrong tables or columns, you can change the calculation
once and all reports using the calculation change to show the new calculation.

Steps
1. Close any open reports.
2. From the Catalog menu, click Folders.
3. In the Catalog Folders box, click the calculation you want to change.
4. Click Edit.
5. Click the part of the calculation you want to change.
6. Change the expression and click OK.
For more information about storing a calculation in the catalog, see "Create a Calculation
Stored in the Catalog" (p. 53).
7. Click OK.

Related Topics
•
•
•
•

"Remove Folders and Items in Folders" (p. 20)
"Store a Summary in the Catalog" (p. 54)
"Use a Calculation Stored in the Catalog" (p. 54)
"Work with Calculations Stored in the Catalog" (p. 53)
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Description
A prompt is an expression that you set up to enable users to filter data by typing or picking a
value, or a series of values when the report opens. Prompts help users quickly find the
information they need from a report.
There are two kinds of prompts: picklist and type-in. For type-in prompts, the user types a value
on which the report filter is based. Picklist prompts retrieve their values from a text file (file
picklist), from a data item in another report (report picklist), or from a data item the catalog
(catalog picklist).
A prompt stored in a catalog is called a catalog prompt.

Example
You create a report listing current product inventory and price. The report is long and users have
to scroll through all the data to locate specific price and stock information.
To make the report more usable, you create a prompt to enable users to pick the name of the
item whose price and stock data they want to see. You store the prompt in the catalog so all
users can use the prompt.

What You Can Do
You can store a prompt in a catalog, add a prompt stored in the catalog to a report, and modify
or delete any prompt in the catalog. You can use the Prompt Manager to
• create new prompts in a report
• re-order the prompts
• modify existing prompts in the report
• delete prompts from the report

Tip
•

To quickly change the filter value for the data in a report place a Prompt button on your
toolbar.

Notes
•

•

•

Impromptu does not allow circular prompt references: you cannot create a prompt using a
data item from the report you are viewing. You can however, make a copy of your report,
and create a prompt using the data item from the copied report.
If you use the characters, '|' or ',' as prompts when opening a report, the report will fail. If you
want to use these characters in prompts, precede them with the '%' character, for example,
'%|' or '%,'.
You can access the Prompt Manager using OLE automation. For more information, see the
Impromptu Macro online help.
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Related Topics
•
•
•
•
•
•
•
•
•
•

"Create a Catalog Prompt" (p. 58)
"Create a Prompt in a Report" (p. 60)
"Hide Prompts from Users" (p. 99)
"Insert Parameters in a Stored Procedure Call" (p. 98)
"Modify a Catalog Prompt" (p. 59)
"Modify a Prompt in a Report" (p. 62)
"Remove a Catalog Prompt from a Report" (p. 60)
"Remove Folders and Items in Folders" (p. 20)
"Use a Catalog Prompt in a Report" (p. 60)
"Work with Conditions, Calculations and Prompts" (p. 47)

Create a Catalog Prompt
Description
You can create a catalog prompt, so you and your users can use the stored prompt in any
reports that are based on the catalog.

Steps
1. Open or create a catalog.
2. From the Catalog menu, click Folders.
3. Click Prompt.
The Prompt Definition dialog box appears.
4. In the Name box, type the name of the prompt to appear in the Folders dialog box.
5. In the Message box, type the message users see in the Prompt dialog box when the report
opens.
Note: If you are creating a date prompt, include the date format that users must enter in the
prompt message. For example, your message should look like this: "Type the start date
(yyyy-mm-dd)."
6. From the Type box, click the type of prompt you want to create.
•

If you click Type In, the user types a value on which the report filter is based. You define
the type of value in the Data Type list box. In the Default Value box, type a default value
to use if the user does not type anything.

•

If you click File Picklist, the user selects a value from an existing text file that contains
one value on each line. Click Browse to specify the file to use for the picklist values.
Note: Select the Sort Values check box to sort a file picklist prompt in ascending order.
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•

If you click Report Picklist, the user selects a data item for filtering from an existing
report. Click Browse to specify the report. Select the Report Data Item from the list. If
you want the user to select one data item in the prompt (for example, Store Name) but
have a different item appear in the report (for example, Contact Person), select a data
item and click Display to use it in the prompt, and then select a different item and click
Use for the corresponding item to appear in the report.

•

If you click Catalog Picklist, the user selects a data item for filtering the report from the
catalog; select the catalog data item from the Catalog Columns.
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7. If you are defining a prompt for use in stored procedure reports, click Advanced and check
the settings in the table below. Otherwise, go to step 8.
For

Do the following

Database Data Type Specify the data type of the stored
procedure parameter. For information about
datatypes, see the Deploying Impromptu
Applications online book.
Use the Default
Value

Select to use the default value specified for
the Type In prompt. Use for stored
procedure parameters that are constants;
the user will not be prompted to provide any
value.

Size

Specify (in bytes) the size of the stored
procedure parameter.

Precision

Specify the total number of digits on either
side of the decimal point that can be
represented by this prompt.

Scale

Specify the order of magnitude of the
number. For example, if the scale is two,
the number 1234 is displayed as 12.34
(because the decimal point is moved two
places to the left).

8. Click OK to create the prompt and return to the Folders dialog box.

Notes
•
•

To move a prompt in the Folders dialog box, drag it.
The default maximum number of entries in a file picklist is 100. You can edit the File Picklist
value in the Impromptu.ini file to change this default.

Related Topics
•
•
•
•

"Modify a Catalog Prompt" (p. 59)
"Remove a Catalog Prompt from a Report" (p. 60)
"Use a Catalog Prompt in a Report" (p. 60)
"Work with Prompts" (p. 57)

Modify a Catalog Prompt
Description
You may want to change the text that shows in a prompt when users open a report. You can also
change the filter values that show in the prompt, so the users can filter the report on a new set of
values.

Steps
1. Open or create a catalog containing a prompt.
2. From the Catalog menu, click Folders.
3. Click the prompt you want to change, and click the Edit button.
4. Change the prompt as required.
5. Click OK twice.
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Related Topics
•
•
•
•

"Create a Catalog Prompt" (p. 58)
"Remove a Catalog Prompt from a Report" (p. 60)
"Use a Catalog Prompt in a Report" (p. 60)
"Work with Prompts" (p. 57)

Use a Catalog Prompt in a Report
Description
You can use prompts stored in the catalog in your reports. This enables you to re-use your most
frequently used prompts without having to re-create them for every report.

Steps
1. Create or open a report that uses a catalog containing a prompt.
2. From the Report menu, click Query.
3. Click the Filter tab, and define an expression for the filter.
4. Double-click Catalog Columns to open the Catalog dialog box.
5. Click the prompt you want to insert, and click OK.
Note: A prompt is identified by the question mark icon.
6. Finish defining the filter expression and click OK.

Related Topics
•
•
•
•

"Create a Catalog Prompt" (p. 58)
"Modify a Catalog Prompt" (p. 59)
"Remove a Catalog Prompt from a Report" (p. 60)
"Work with Prompts" (p. 57)

Remove a Catalog Prompt from a Report
Description
You can remove a catalog prompt you no longer need from your report. The Prompt Manager
still shows the catalog prompt although it is not being used in your report.

Steps
1. Create or open a report that uses a prompt from the catalog.
2. From the Report menu, click Query.
3. Click the Filter tab.
4. Click the prompt expression and press Delete to remove only the prompt.
Note: Click Clear to remove the entire filter expression, including the prompt.

Related Topics
•
•
•
•

"Create a Catalog Prompt" (p. 58)
"Modify a Catalog Prompt" (p. 59)
"Use a Catalog Prompt in a Report" (p. 60)
"Work with Prompts" (p. 57)

Create a Prompt in a Report
Description
You can create a prompt for the current report.
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Steps
1. Create or open a report.
2. From the Report menu, click Prompt Manager.
3. Click New.
4. In the Name box, type the name the prompt to appear in the Folders dialog box.
5. In the Message box, type the message users see in the Prompt dialog box when the report
opens.
Note: If you are creating a date prompt, include the date format that users must enter in the
prompt message. For example, your message should look like this: "Type the start date
(yyyy-mm-dd)."
6. From the Type box, click the type of prompt you want to create.
•

If you click Type In, the user types a value on which the report filter is based. You define
the type of value in the Data Type list box. In the Default Value box, type a default value
to use if the user does not type anything.

•

If you click File Picklist, the user selects a value from an existing text file that contains
one value on each line. Click Browse to specify the file to use for the picklist values.
Note: Select the Sort Values check box to sort a file picklist prompt in ascending order.
•

If you click Report Picklist, the user selects a data item for filtering from a saved report.
Click Browse to specify the report. Select the report data item from the list. If you want
the user to select one data item in the prompt (for example, Store Name) but have a
different item appear in the report (for example, Contact Person), select a data item and
click Display to use it in the prompt, and then select a different item and click Use for the
corresponding item to appear in the report.

•

If you click Catalog Picklist, the user selects a data item for filtering the report from the
catalog; select the catalog data item from the Catalog Columns.

7. If you are defining a prompt for a stored procedure report, click Advanced and check the
settings in the table below. Otherwise, go to step 8.
For

Do the following

Database Data Type

Specify the data type of the stored
procedure parameter. For information
about datatypes, see the Deploying
Applications online book.

Use the Default
Value

Select to use the default value specified
for the Type In prompt. Use for stored
procedure parameters that are constants;
the user will not be prompted to provide
any value.

Size

Specify (in bytes) the size of the stored
procedure parameter.

Precision

Specify the total number of digits on either
side of the decimal point that can be
represented by this prompt.

Scale

Specify the order of magnitude of the
number. For example, if the scale is two,
the number 1234 is displayed as 12.34
(because the decimal point is moved two
places to the left).

8. Click OK to create the prompt and return to the Prompt Manager dialog box. Click OK.
9. From the Report menu, click Query.
10. Click the Filter tab and define an expression for the filter.
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11. In the Available Components box, click Prompt Manager to show the defined prompts.
12. Click the prompt you created, and click OK.
13. Finish defining the filter expression and click OK.

Notes
•

•

•
•
•

Impromptu does not allow circular prompt references; you cannot create a prompt using a
data item from the report you are viewing. You can however make a copy of your report, and
create a prompt using the data item you want from the copy.
If you use the characters, '|' or ',' as prompts when opening a report, the report will fail. If you
want to use these characters in prompts, precede them with the '%' character, for example,
'%|' or '%,'.
You can drag and drop prompts to re-order them in the Prompt Manager. The report user
sees the prompts in the resulting order.
The default maximum number of entries in a file picklist is 100. You can edit the File Picklist
value in the Impromptu.ini file to change this default.
To create a prompt available to every report based on the same catalog, see "Create a
Catalog Prompt" (p. 58).

Related Topics
•
•
•

"Modify a Prompt in a Report" (p. 62)
"Remove Folders and Items in Folders" (p. 20)
"Work with Prompts" (p. 57)

Modify a Prompt in a Report
Description
You can modify the name and other properties of a prompt you create in a report.

Steps
1. Create or open a report that containing a prompt.
2. From the Report menu, click Prompt Manager.
3. Click the prompt you want to modify, and click Edit.
4. Changes the prompt as required and click OK twice.
For more information about defining a prompt, see "Create a Prompt in a Report" (p. 60).

Note
•

To modify a catalog prompt, see "Modify a Catalog Prompt" (p. 59).

Related Topics
•
•

62 Impromptu ( R )

"Remove Folders and Items in Folders" (p. 20)
"Work with Prompts" (p. 57)
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Description
The user profile consists of one or more user classes which share the same access privileges
and access similar data within a catalog. User class defines capabilities for a group of users and
can contain subordinate user classes. For example, sales representatives on the East coast
need to view only data on customers on the East coast, while sales representatives on the West
coast need to view data on customers on the West coast.
When you have many users, each with unique data requirements, you can define several user
classes to address their various needs. Each user class restricts data access to a specific
subset of information. For example, managers and their employees may use the same catalog,
but only the managers can view employee salary data. By creating two user classes, one for the
managers and one for the employees, you can ensure that the employee user class cannot view
restricted salary information.
Each user class (except for the Creator user class) must be based upon another user class.
User classes are shown as a parent-child hierarchy in the User Classes tab (User Profiles dialog
box).
Note: If Access Manager is installed on your computer, then security could be controlled by
Access Manager. For more information about Access Manager security, see "Use Access
Manager to Control Security" (p. 67).

Why Do You Use a Password?
You can protect a catalog by assigning a password to a user class, which all user class
members must enter to use the catalog. Passwords can consist of alphanumeric characters and
spaces.
Providing you have the correct authorization, you can set user class passwords for any
subordinate user classes. For example, from the Creator user class you can set passwords for
all other user classes.

What You Can Do
You can
• create user classes that match the needs of your user community
• protect catalogs by assigning passwords to each user class accessing that catalog
• store database user IDs and passwords within the catalog
When you create a shared, distributed, or secured catalog, Impromptu automatically creates
two user classes—Creator and User. You can change these user classes and create other user
classes. For your users to access the catalog you create, there must be at least one user class
besides the Creator user class.

Notes
•
•
•

Passwords are case-sensitive.
When you create a restriction for a user class, that restriction is inherited by all child
classes.
When you grant a privilege for a user class, that privilege is not inherited by all its child
classes.
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Related Topics
•
•
•
•
•
•
•

"Assign or Change a Password for a User Class" (p. 66)
"Create a User Class" (p. 64)
"Edit a User Class" (p. 65)
"Prompt a User Class for a Database Password" (p. 67)
"Remove a Password from a User Class" (p. 66)
"Remove a User Class" (p. 65)
"Store a Database Password for a User Class" (p. 67)

Create a User Class
Description
You can create a user class for each group or department.
From the Creator user class, you can create, change, and remove user classes. You can also
create, change, and remove any subordinate user classes if your user class has the appropriate
access.
All user classes (except for the Creator user class) must be based on another user class. Create
at least one user class based on the Creator user class, and then do one of the following:
• continue to base new user classes on the Creator user class
• use your new user class as the base
You can share some of the administrator responsibilities by enabling one or more user classes
to create subordinate user classes. For example, you could create a user class called Team
Leaders, and allow the team leaders to create user classes for their team members.

Example
You set up a user class for the Sales department that lets them see only sales data. You then set
up another user class in the same catalog for the Accounting department that lets them see only
financial data.
When the catalog is secured by a namespace, user classes in the catalog must also exist in the
namespace.

Steps to Create a User Class
1. From the Catalog menu, click User Profiles, and then click the User Classes tab.
2. Click the user class on which you want to base the new user class.
Note: You may need to double-click a user class to see the hierarchy of subordinate classes
within this catalog.
3. Click Add.
4. In the Class Name box, type a unique name for the new user class.
5. If you want to protect this catalog, type a password in the User Class Password box.
6. In the Verify box, type the password again to verify the password set in step 5, and then click
OK.
7. Repeat steps 2 to 6 to create additional user classes and click OK.
Click Cancel to close the User Profiles dialog box without creating the user class.

Steps to Allow a User Class to Create Other User Classes
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. Select the Add/Modify User Classes check box, and click OK.

Notes
•
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•
•
•
•

When you create a shared, secured, or distributed catalog, Impromptu automatically
creates two user classes: Creator and User.
Each child user class inherits the same set of privileges and restrictions as the parent user
class on which it is based.
Child user classes can have fewer but not more, privileges than the parent user class.
Only the Creator user class can add or modify the user classes defined in a master
distributed catalog.

Tip
•

To obtain a better view of a large list of user classes, resize the User Profiles dialog box.

Related Topics
•
•
•

"Edit a User Class" (p. 65)
"Remove a User Class" (p. 65)
"User Profiles and Privileges" (p. 63)

Edit a User Class
Description
You can edit user classes. You can assign or change the password for the Creator user class. If
you have appropriate access, you can edit the user class names and passwords.
You cannot edit the user class that you are currently logged on with, unless you are logged on
as a Creator user class.

Steps
1. From the Catalog menu, click User Profiles, and then click the User Classes tab.
2. In the User Class box, click the user class you want to edit.
Note: You may need to double-click a user class to see its hierarchy of subordinate classes
within the catalog.
3. Click Edit.
4. If you want to edit the user class name, type a new name for the user class in the Class
Name box.
5. If you want to assign or edit the password, type the new password in the User Class
Password box.
6. In the Verify box, type the password again, and then click OK, to verify the password edited
in step 5.
7. Repeat steps 2 to 6 to edit other user classes, and click OK.

Related Topics
•
•
•
•

"Assign or Change a Password for a User Class" (p. 66)
"Create a User Class" (p. 64)
"Remove a User Class" (p. 65)
"User Profiles and Privileges" (p. 63)

Remove a User Class
Description
You can remove subordinate user classes that are no longer required. You cannot remove the
Creator user class.
Use caution when deleting user classes, as all subordinate classes (child) of the user class
(parent) are automatically deleted.
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Steps
1. From the Catalog menu, click User Profiles, and then click the User Classes tab.
2. In the User Class dialog box, click the user class you that want to remove.
Note: You may need to double-click a user class to see its hierarchy of subordinate classes
within the catalog.
3. Click Remove.
4. Repeat steps 2 and 3 to remove other user classes, and click OK.

Note
•

Click Cancel to close the User Profiles dialog box without removing the user class.

Related Topics
•
•
•

"Create a User Class" (p. 64)
"Edit a User Class" (p. 65)
"User Profiles and Privileges" (p. 63)

Assign or Change a Password for a User Class
Description
You can protect a catalog by assigning passwords to each user class accessing the catalog. You
can change passwords at any time.

Steps
1. From the Catalog menu, click User Profiles, and then click the User Classes tab.
2. In the User Class dialog box, click the user class you want to modify.
Note: You may need to double-click a user class to view its hierarchy of classes within the
catalog.
3. Click Edit.
4. In the User Class Password box, type the new password, or change the existing password.
5. In the Verify box, type the password again to verify the password.
6. Click OK, and click OK again to close the User Profiles dialog box.

Related Topics
•
•
•
•

"Prompt a User Class for a Database Password" (p. 67)
"Remove a Password from a User Class" (p. 66)
"Store a Database Password for a User Class" (p. 67)
"User Profiles and Privileges" (p. 63)

Remove a Password from a User Class
Description
You can remove the password you have set for any user class.

Steps
1. From the Catalog menu, click User Profiles, and then click the User Classes tab.
2. In the User Class box, click the user class you want to modify.
Note: You may need to double-click a user class to view its nested hierarchy of classes
within the catalog.
3. Click Edit.
4. In the User Class Password box, click the password and press the Delete key.
5. Click OK, and click OK again to close the User Profiles dialog box.
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Related Topics
•
•
•
•

"Assign or Change a Password for a User Class" (p. 66)
"Prompt a User Class for a Database Password" (p. 67)
"Store a Database Password for a User Class" (p. 67)
"User Profiles and Privileges" (p. 63)

Store a Database Password for a User Class
Description
You can maintain security and simplify login by suppressing the prompts for the database user
ID and password. Impromptu does this by embedding the user ID and password within the user
class profile.

Steps
1. From the Catalog menu, click User Profiles, and then click the Database tab.
2. In the User Class dialog box, click the user class you want to modify.
3. Click the Database Logon option button.
4. In the User ID box, type the database user ID.
5. In the Password box, type the database password.
6. In the Verify box, type the password again, and then click OK.

Related Topics
•
•
•
•

"Assign or Change a Password for a User Class" (p. 66)
"Prompt a User Class for a Database Password" (p. 67)
"Remove a Password from a User Class" (p. 66)
"User Profiles and Privileges" (p. 63)

Prompt a User Class for a Database Password
Description
By default, Impromptu prompts user classes to enter the user ID and password for the database.

Steps
1. From the Catalog menu, click User Profiles, and then click the Database tab.
2. In the User Profiles dialog box, click the user class you want to modify.
3. Click the Prompt for Database Security option button, and click OK.

Related Topics
•
•
•
•

"Assign or Change a Password for a User Class" (p. 66)
"Remove a Password from a User Class" (p. 66)
"Store a Database Password for a User Class" (p. 67)
"User Profiles and Privileges" (p. 63)

Use Access Manager to Control Security
You can use Impromptu to control security or you can use Cognos Access Manager to control
security for your Cognos applications. Other applications, such as Architect, PowerPlay,
Impromptu Web Reports, and Cognos Query, use Access Manager for security as well. If you
integrate with these applications, you may want to use Access Manager to prevent having to log
on more than once.
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Access Manager stores a list of users and user classes, along with passwords and permissions,
in a namespace on a directory server. When you start a Cognos application, Access Manager
compares your user name and password to information in the namespace.

Security When You Specify a Namespace
You can use the Catalog Properties dialog box to specify a namespace for Access Manager to
check every time you open the catalog. If you aren’t listed in the namespace, Impromptu denies
access.

Security When You Don't Specify a Namespace
If you don’t specify a namespace, but you have Access Manager set up on your computer,
Impromptu checks a default namespace first. If you aren’t listed in the default namespace, you
can still log on using catalog security. You can also use Access Manager to add your operating
system user name and password to the namespace so that you can log on to the catalog
automatically.
Note: If Access Manager isn't on your computer, then security is in based in the catalog. For
more information about catalog-based security, see "User Profiles and Privileges" (p. 63).
For more information about integrating Impromptu and Access Manager, see the Impromptu
Administrator's Guide. For more information about Access Manager, see the Access Manager
documentation.
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Chapter 11: Control the User Environment
Description
User classes let you
• provide your users with focused views of your data
• restrict access to sensitive data
Apply privileges and filters to your user classes to control access to tables, columns, and
folders. For more information, see "Use Filters to Control Access to Data" (p. 70).
To set user environment controls for a hierarchy of user classes, change the user class at the
top of the hierarchy. Subordinate user classes inherit controls and settings from the user class at
the top.

Example
You have two groups of users requiring access to the same catalog. However, one group needs
view-only access to standard reports, while the other group needs edit access to the data
structure, catalog structure, and reports.

What You Can Do
You can control whether a user class can
• access certain data in the catalog by setting access privileges at the table, column,
database, or folder level within the catalog
• edit the catalog structure
• create or edit reports
The Creator user class can control the environment for other user classes. Subordinate user
classes inherit the permissions and settings of the parent user class. Any user class with the
appropriate permissions, may control the environment for subordinate user classes. For
example, as a member of the Managers user class you have permission to control the
environment for a subordinate Employees user class
Note: By default, all user classes have access to all data in the catalog.

Related Topics
•
•
•
•
•

"Control Access to Folders and Items in Folders" (p. 70)
"Control Access to Tables or Columns" (p. 69)
"Control Creating and Editing Reports" (p. 72)
"Control Editing of the Catalog Structure" (p. 71)
"User Profiles and Privileges" (p. 63)

Control Access to Tables or Columns
Description
You can control access to sensitive or protected data by limiting the access of specific user
classes. You can also re-instate user class access to data. By default, all user classes have
access to all the data in a catalog.
If a user class is denied access to a column in a table, the user can’t run existing reports
accessing the column. If a user class is granted access to a column in a table, but denied
access to the same column in a folder, the user can run an existing report showing the restricted
column. The user cannot create a new report using that column, however, because it does not
appear in the catalog.
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Steps
1. From the Catalog menu, click User Profiles, and then click the Table Access tab.
2. In the User Class box, click the user class you want to modify.
3. In the Catalog Tables box, double-click the appropriate table.
4. Select the appropriate column, table, or database.
5. Click Grant Access to enable access, or click Deny Access to prevent access, and then click
OK.
Note: An icon beside the name of the column, table, owner, or database indicates if access
is denied.

Related Topics
•
•
•
•
•

"Control Access to Folders and Items in Folders" (p. 70)
"Control Creating and Editing Reports" (p. 72)
"Control Editing of the Catalog Structure" (p. 71)
"Control the User Environment" (p. 69)
"Use Filters to Control Access to Data" (p. 70)

Control Access to Folders and Items in Folders
Description
You can enable or prevent user class access to specific folders or folder items in the catalog.

Steps
1. From the Catalog menu, click User Profiles, and then click the Folder Access tab.
2. In the User Class box, click the user class you want to modify.
3. In the Permission To box, click Access or Select Values as required.
4. In the Catalog Folders box, click the folders or items the user class can access or cannot
access.
5. Click Grant or Deny.
Note: If you deny Select Values to a specific object (such as a folder), the user class cannot
perform a select values operation, on any column in that folder or sub-folder.
6. Click OK.
Note: An icon appears beside the folder name, indicating if access is denied to this folder.

Related Topics
•
•
•
•
•

"Control Access to Tables or Columns" (p. 69)
"Control Creating and Editing Reports" (p. 72)
"Control Editing of the Catalog Structure" (p. 71)
"Control the User Environment" (p. 69)
"Use Filters to Control Access to Data" (p. 70)

Use Filters to Control Access to Data
Description
For any user class you can define a filter that provides focused views of the data by limiting the
scope of data retrieved from a table or column. Filters can also improve performance by limiting
the number of records retrieved. In addition, use filters to restrict access to sensitive data. This
is called security by value.
You can modify or remove filters you created for a user class.
All reports using the same filter automatically change when you modify the filter.
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Examples
You apply a filter to the Region table to filter unnecessary data. When a user class creates a
report using the Region table, they see only data for their region. The users do not have to
manually filter out data.
The filter currently applied to the Region table enables a user class to access data for their
region when they create a report. You modify the filter so that new regions added to the Region
table are automatically available to the applicable user class.

Steps to Create or Modify a Filter for a User Class
1. From the Catalog menu, click User Profiles, and then click the Filters tab.
2. In the User Classes box, click the user class for which you want to create or modify a filter.
3. In the Catalog Tables box, double-click the database component.
4. Select the table for which you want to create or modify a filter.
5. Click Edit.
6. In the Available Components box, double-click Catalog Columns.
7. Click the column for which you want to create or modify a filter, and click OK.
8. Build or modify a filter and click OK.
9. Click OK.

Steps to Remove a Filter from a User Class
1. From the Catalog menu, click User Profiles, and then click the Filters tab.
2. In the User Classes box, select the user class from which you want to remove a filter.
3. In the Catalog Tables box, double-click the database component.
4. Select the table with the filter you want to remove.
Note: Tables with associated filters show a filter icon beside their name.
5. Click Clear to remove the filter from the user class, and click OK.

Related Topics
•
•
•
•
•

"Control Access to Folders and Items in Folders" (p. 70)
"Control Access to Tables or Columns" (p. 69)
"Control Creating and Editing Reports" (p. 72)
"Control Editing of the Catalog Structure" (p. 71)
"Control the User Environment" (p. 69)

Control Editing of the Catalog Structure
Description
You can modify catalog structure by editing the folders in the catalog. Any user class that can
edit the catalog structure has complete read-write access to that catalog.
Place catalogs in a read-only directory to prevent users from changing the catalog, even if they
have permission to edit the Impromptu folders.

Distributed Catalogs
By default, only the Creator user class can modify the structure of a master distributed catalog.
User classes can modify certain aspects of their personal distributed catalog structure. You can
prevent a user class from editing the catalog structure.

Shared Catalogs
By default, only the Creator user class can edit the catalog structure of a shared catalog.
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While you edit the structure of a shared catalog, all other subordinate user classes cannot open
the catalog. All user classes use the same copy of the catalog, and you cannot edit the folders
until everyone using the shared catalog closes the catalog.

Secured Catalogs
By default, only the Creator user class can edit the catalog structure of a secured catalog.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. Select the Edit Folders check box to enable access, or clear the Edit Folders check box to
prevent access, and then click OK.

Related Topics
•
•
•
•
•

"Control Access to Folders and Items in Folders" (p. 70)
"Control Access to Tables or Columns" (p. 69)
"Control Creating and Editing Reports" (p. 72)
"Control the User Environment" (p. 69)
"Use Filters to Control Access to Data" (p. 70)

Control Creating and Editing Reports
Description
By default, all user classes can create and edit reports. You can prevent a user class from
creating and editing reports, although the user class can run previously created reports. You can
restore reporting, editing, and creation capabilities at any time.
User classes cannot create and edit reports for secured catalogs. Secured catalog users can
only run previously created reports.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. Select the Create/Edit Reports check box to enable access, or clear the Create/Edit Reports
check box to prevent access, and then click OK.

Note
•

Report consumers can create drill-through links when they have no update privileges to
modify a report.

Tip
•

Place standard or shared reports in read-only folders so users cannot modify them. Users
can then create their own reports while using your reports.

Related Topics
•
•
•
•
•
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Chapter 12: Manage the Impact on the Network
and Database
Description
Performance can become an issue on a network supporting a large number of users who
frequently retrieve large amounts of data. As the administrator, you can reduce performance
issues by setting operational constraints for each user class.
You can manage the impact on the network and database by controlling user actions such as
• the number of characters a user class can retrieve from large text items (BLOBs)
• the number of rows a user class can retrieve
• the number of tables that can be used by a report
• sorts on non-indexed columns
• the ability to create outer joins
• the display of duplicate rows of data in a report
• the creation of cross-product reports
• direct entry of SQL
You can also manage the impact by defining runtime parameters. For example,
• limiting the execution time of queries
• minimizing the time a user class is connected to the database
• balancing the client/server load
• assigning weights to tables
• restricting the use of select distinct
• specifying the retrieval of large results sets using bulk fetch to increase performance

Related Topics
•
•
•
•
•
•
•
•
•
•
•
•

"Adjust the Client/Server Balance" (p. 79)
"Assign Weights to Tables" (p. 80)
"Control Sorting on Non-Indexed Columns" (p. 75)
"Control the Ability to Enter SQL Directly" (p. 77)
"Control the Creation of Cross-Product Queries" (p. 77)
"Control the Creation of Outer Joins" (p. 76)
"Control the Number of Rows Retrieved" (p. 74)
"Control the Number of Tables Retrieved" (p. 75)
"Control the Retrieval of Large Text Items" (p. 73)
"Control the Time a User Class Can Run Queries" (p. 78)
"Restrict the Time a User Class Is Connected to the Database" (p. 79)
"Suppress Duplicate Rows of Data" (p. 76)

Control the Retrieval of Large Text Items
Description
You can control the number of characters user classes can retrieve from large text items or
binary large objects (BLOBs). Impromptu truncates BLOBs using your defined maximum size.
The Creator user class can set the maximum volume of text a subordinate user class can
retrieve. Members of any other user class can restrict only the volume of text retrieved for their
subordinate user classes.
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You can also control the text BLOB limit at the query level by typing the limit in the Maximum
Number of Characters to be Retrieved for Large Text Items box (Access tab, Query dialog box).
For example, you set a general limit for retrieving large text items for all reports created by a
user class, but you also set a different, more restrictive limit for any specific report run by the
same user class.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. In the Maximum Number of Characters to be Retrieved for Large Text Items box, type a
number from 1 to 65534 as the number of characters the user class can retrieve, and click
OK.

Note
•
•

To set unlimited retrieval, type a number larger than 65534 and click OK. Impromptu resets
the box when there is no limit.
To have items span more than one page, the height must be set to dynamic.

Related Topics
•
•
•

"Control the Number of Rows Retrieved" (p. 74)
"Control the Number of Tables Retrieved" (p. 75)
"Manage the Impact on the Network and Database" (p. 73)

Control the Number of Rows Retrieved
Description
The administrator can edit the user class profile to control the number of rows a user class can
retrieve.
For new or changed reports, Impromptu counts rows as they are retrieved across the network
and issues a warning or stops retrieving at the pre-set number.
The Creator user class can set the number of rows any subordinate user class can retrieve. All
other user classes, with add/modify permission, can further restrict the number of rows
subordinate user classes can retrieve.
The Access tab (Query dialog box) can also control the number of rows retrieved at the query
level. For example, you set a general limit for the number of rows retrieved for all reports created
by a user class, but you set a different limit for a specific report run by the same user class.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. In the Warn At box (under Data Retrieval Limits box), type or modify the number of rows
retrieved when the user class is warned and then click OK.
4. In the Stop At box (under Data Retrieval Limits box), type or modify the maximum number of
rows retrieved and then click OK.

Related Topics
•
•
•
•
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Control the Number of Tables Retrieved
Description
To increase the performance of your query, you can control the number of tables that a user
class can retrieve.
The Creator user class can control the number of tables a user class can retrieve for a report.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. In the Warn At box (under Report Table Limits box), type or modify the number of tables
retrieved when the user class is warned and click OK.
4. In the Stop At box (under Report Table Limits box), type or modify the maximum number of
tables retrieved and then click OK.

Related Topics
•
•
•

"Control the Number of Rows Retrieved" (p. 74)
"Control the Retrieval of Large Text Items" (p. 73)
"Manage the Impact on the Network and Database" (p. 73)

Control Sorting on Non-Indexed Columns
Description
Sorting data is faster if your database has indexed columns, or if you have defined columns as
keys for tables. For example, LastName is the indexed column for the Customers table. Your
users sort by only the LastName column to make data retrieval faster.
By default, any user class can sort on non-indexed columns. You can improve Impromptu's data
retrieval performance by
• preventing a user class from sorting on non-indexed columns
• warning a user class that sorting on non-indexed columns is time-consuming
The Creator user class can set privileges for sorting on non-indexed columns for any
subordinate user class. All other user classes, with permission to add or modify user class
privileges, can set only more restrictive privileges for subordinate user classes. For example, if
you have a user class called Manager with a subordinate user class called Employees, then the
Manager user class can set privileges for the Employees user class.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want you want to modify.
3. In the Sorting on Non-indexed Columns box, do one of the following:
•

To prevent a user class from sorting on non-indexed columns, click Prevent.

•

To issue a warning message when the user class sorts on a non-indexed column, click
Warn.

•

To allow the user class to sort on non-indexed columns, click Allow.

4. Click OK.

Related Topics
•
•
•
•

"Control the Creation of Cross-Product Queries" (p. 77)
"Control the Creation of Outer Joins" (p. 76)
"Manage the Impact on the Network and Database" (p. 73)
"Suppress Duplicate Rows of Data" (p. 76)
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Control the Creation of Outer Joins
Description
Outer joins are a type of join that retrieves all of the rows from one table even when there are no
matching rows in another table. Outer joins slow Impromptu's performance and are
time-consuming to execute.
The Creator user class can set privileges for creating outer joins for any subordinate user class.
All other user classes, with permission to add or modify user class privileges, can set only more
restrictive privileges for subordinate user classes. For example, if you have a user class called
Manager with a subordinate user class called Employees, then the Manager user class can set
privileges for the Employees user class.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. In the Outer Joins box, do one of the following:
•

To prevent a user class from creating an outer join, click Prevent.

•

To issue a warning message when the user class uses an outer join, click Warn.

•

To allow the user class to use an outer join, click Allow.

4. Click OK.

Related Topics
•
•
•
•

"Control Sorting on Non-Indexed Columns" (p. 75)
"Control the Creation of Cross-Product Queries" (p. 77)
"Control the Time a User Class Can Run Queries" (p. 78)
"Manage the Impact on the Network and Database" (p. 73)

Suppress Duplicate Rows of Data
Description
You can control how a user class displays duplicate rows of data in a report by
• preventing a user class from displaying duplicate rows of data in a report
• warning a user that duplicate rows of data are suppressed
• allowing a user class to display duplicate rows of data in a report
The Creator user class can set privileges for displaying duplicate rows of data for any
subordinate user class. All other user classes, with permission to add or modify user class
privileges, can set only more restrictive privileges for subordinate user classes. For example, if
you have a user class called Manager with a subordinate user class called Employees, then the
Manager user class can set privileges for the Employees user class.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. In the Eliminate Duplicate Rows (Select Distinct) box, do one of the following:
•

To prevent the user class from displaying duplicate rows of data, click Prevent.

•

To issue a warning message when the user class displays duplicate rows of data, click
Warn.

•

To allow the user class to display duplicate rows of data, click Allow.

4. Click OK.
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Related Topics
•
•

"Control the Number of Rows Retrieved" (p. 74)
"Manage the Impact on the Network and Database" (p. 73)

Control the Creation of Cross-Product Queries
Description
Cross-product queries retrieve data from tables which are not joined. They take a long time to
generate, can show meaningless results, and may retrieve a large number of rows of data.
You can control how a user class uses cross-product queries by
• enabling a user class to create cross-product queries
• preventing a user class from creating cross-product queries
• warning a user class that creating cross-product queries is time-consuming
By default, no user classes can create cross-product queries.
The Creator user class can set privileges for creating cross-product queries for any subordinate
user class. All other user classes, with permission to add or modify user class privileges, can set
only more restrictive privileges for subordinate user classes. For example, if you have a user
class called Manager with a subordinate user class called Employees, then the Manager user
class can set privileges for the Employees user class.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. In the Cross-product Queries (No Table Joins) box, do one of the following:
•

To prevent the user class from creating cross-product queries, click Prevent.

•

To issue a warning message when the user class creates cross-product queries, click
Warn.

•

To enable the user class to create cross-product queries, click Allow.

4. Click OK.

Related Topics
•
•
•

"Control Sorting on Non-Indexed Columns" (p. 75)
"Control the Creation of Outer Joins" (p. 76)
"Manage the Impact on the Network and Database" (p. 73)

Control the Ability to Enter SQL Directly
Description
You can enable a user class to enter SQL directly to create queries if
• you need to have Impromptu run a complex query that cannot be generated automatically
(such as CONNECT BY in Oracle)
• the query is used in, or created by, another application
• you are an expert in SQL and want to use your knowledge to create queries
The Creator user class can control a user class' ability to enter SQL directly to create queries.
By default, only the Creator user class can enter SQL directly.
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Disadvantages of Entering SQL Directly
The following are disadvantages of entering SQL directly:
• A poorly defined or not valid SQL query can be time-consuming to execute.
• Any restrictions you set in the User Profiles dialog box and the Access tab (Query dialog
box) no longer apply, except for limits set on the number of rows retrieved and the length of
time a user class can run queries. For example, a user has access to all the tables and
columns in the catalog, including data the user may not have permission to see.
• Security-by-value conditions and filters are ignored.
• Catalog portability is reduced.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. Select the Direct Entry SQL check box.
4. Click OK.

Notes
•

•

If a user inadvertently sets direct SQL editing (Profile tab, Query dialog box), then that user
can only update the report by typing SQL statements. The user must access all of
Impromptu’s advanced reporting features such as sorting, grouping, and filtering, through
SQL.
For more information about entering SQL directly, see "Use SQL" (p. 85).

Related Topics
•
•
•

"Control the Number of Rows Retrieved" (p. 74)
"Control the Time a User Class Can Run Queries" (p. 78)
"Manage the Impact on the Network and Database" (p. 73)

Control the Time a User Class Can Run Queries
Description
You can control the time a user class can run a query.
Members of the Creator user class can set this time limit for any user class. All other user
classes, with permission to add or modify user class privileges, can set only more restrictive
privileges for subordinate user classes.
Impromptu first gathers statistics on the report size, so you may have to run the report a few
times to build up the statistical base.
The database you use might have features for controlling execution time as well.

Steps
1. From the Catalog menu, click User Profiles, and then click the Governor tab.
2. In the User Class box, click the user class you want to modify.
3. In the Warn At box (under Query Execution Time Limits box), type or modify the time (in
minutes) when you want to warn the user class and then click OK.
4. In the Stop At box (under Query Execution Time Limits box), type or modify the time (in
minutes) when you want to stop the user class and then click OK.
5. Click OK.

Related Topics
•
•
•
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Restrict the Time a User Class Is Connected to the Database
Description
You can restrict the length of time that a user class is connected to the database by using a
temporary cache to store query results. Impromptu automatically disconnects from the database
once the query is run, and automatically reconnects when you run another query.
Normally, user classes are connected to the database from the time the user opens a catalog
until they close the catalog or disconnect from the database.
The Creator user class, can minimize the time any user class can connect to the database.

Steps
1. From the Catalog menu, click User Profiles, and then click the Client/Server tab.
2. In the User Class box, click the user class you want to modify.
3. Select the Minimize Connection Time to the Database check box and click OK.

Tip
•

You can store the database user ID and password in the catalog so the user is not prompted
for them.

Related Topics
•
•

"Control the Time a User Class Can Run Queries" (p. 78)
"Manage the Impact on the Network and Database" (p. 73)

Adjust the Client/Server Balance
Description
You can adjust the client/server balance so that queries are processed on only the server, with
limited local processing, or with flexible processing.
The Creator user class can adjust the client/server balance for any subordinate user class.

Examples of When You Can Use Each Option
If your users need a query showing the summary before the details
server only
processing

limited local
processing

cannot handle this
query

Impromptu runs two Impromptu runs one query
and computes the total
queries: one for
details, then one for itself
summary, and then
merges the two
queries

flexible processing

If your users need a query of total sales by region with a grand total for the whole report
server only
processing

limited local
processing

cannot handle this Impromptu runs two
query
queries: one for
details, then one for
grand total, and then
merges the two
queries

flexible processing
Impromptu runs one
query, and calculates the
grand total on the
computer
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If your users need a filter with a "sounds like" prompt (when the prompt appears, the user types
a name the query phonetically matches):
server only
processing

limited local
processing

database may not
be able to handle
this query

Impromptu will run the
query but you cannot
sort on the filter

flexible processing
Impromptu will run the
query, with no limits

For more information, see the Impromptu Administrator's Guide.

Steps
1. From the Catalog menu, click User Profiles, and then click the Client/Server tab.
2. In the User Class box, click the user class you want to want to modify.
3. In the Query Processing box, click one of the following option buttons:
•

To run queries completely on the server, click Database Only.

•

To run queries with limited local processing, click Limited Local Processing.

•

To let Impromptu decide where to run queries, click Flexible Processing.

4. Click OK.

Related Topics
•
•

"Assign Weights to Tables" (p. 80)
"Manage the Impact on the Network and Database" (p. 73)

Assign Weights to Tables
Description
You can assign relative weights to the tables in the catalog; normally you assign larger weights
to larger tables. Specify relative sizes of tables, to control which tables are preferred as
intermediate tables in join strategies. Impromptu uses these weights to create SQL queries by
ordering the tables in the FROM clause from smallest to biggest. Smaller tables are always the
preferred tables. In most cases, this enables Impromptu to efficiently optimize query execution.
However, if Impromptu or your database application manipulates the SQL internally, Impromptu
may not be able to maintain the table order in the FROM clause.
By default, tables are added into the catalog with the weight of 5.

Example
You assign a weight of 20 to the Order table, a weight of 10 to the Customer table, and a weight
of 2 to the Reps table. You then want to see, by sales representative, which customers have
ordered products, Impromptu puts the tables in the FROM clause in this order:
Reps, Customer, Order
Why? If direct joins between these tables exist, then data will be selected from the tables in the
order based on table weight. However, in this case, there is no direct join between Rep and
Customer. They have to be joined through the Order table.
And Impromptu creates the table joins in this order:
Rep.Rep_No = Order.Rep_No and Customer.Order_No = Order.Order_No
In many cases, weighting enables you to optimize queries. Advanced databases do a better job
of optimizing queries and are unaffected by the order of tables in the SQL.
Some database optimizers override the weighting option in Impromptu. dBase databases are a
good candidate for the application of table weighting.
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Steps
1. From the Catalog menu, click Tables, and then click the Weighting tab.
2. In the Catalog Tables (Relative Weight) box, click the table or tables with the weight you
want to increase or decrease and do one of the following:
•

To decrease the weight until the desired weight is reached, click Smaller.

• To increase the weight until the desired weight is reached, click Bigger.
You can double-click the table to continue decreasing or increasing the weight.
3. Click OK.

Related Topics
•
•

"Adjust the Client/Server Balance" (p. 79)
"Manage the Impact on the Network and Database" (p. 73)
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Chapter 13: Audit Impromptu Performance
Description
Impromptu can log performance data in audit files. You use this information to determine
whether changes to your reports, catalogs, or Impromptu environment are affecting
performance times.
There are two small applications that come with Impromptu that help you perform auditing: 1)
Audit Configuration and 2) Audit File Processor.
Use the Audit Configuration application to
• enable auditing
• set the audit file location
• configure how much space audit files will take
• store the SQL statements Impromptu uses to get information
Use the Audit File Processor application to
• set the audit file load location
• set the audit data database
• set whether audit files are deleted after loading
• create database tables
• add data from the audit files to the database tables
Each session of Impromptu records all events in the audit file along with important context
information about those events. For example, when you open a report while auditing is turned
on, Impromptu records the name of the report and how long it took to open that report.
To analyze the audit information, use the Audit File Processor to store the data in a relational
database. You can store the data in any database that can be accessed through ODBC. Use the
Audit File Processor to create the database tables, process the audit files, and add data to the
database. Then use Impromptu to create the catalog and reports to analyze the audit file data.
Impromptu Web Reports has its own auditing application and cannot collect auditing data for
Impromptu and vice versa. This is because the log files created are of different versions.
Note: There is no support for Impromptu auditing on UNIX.
A sample auditing catalog (Audit.cat) and a report (Auditing Report.imr) are included in the
Impromptu samples. For more information on these two samples, see the Product Sample
Listing.

Steps
1. Create a new data source.
2. Create a database file for that data source.
If you are using an Access database file (.mdb), create that file using Access, not ODBC
Administrator.
Note: When creating the Access database, set security and user group settings because
you will be prompted for them in the AuditFileProcessor application.
3. Check to see if AuditConfig.exe and AudifFileProcessor.exe are in your
installation_location\Bin folder. If they are, skip to step #4. Otherwise, run the Custom
Installation of Impromptu and select the Audit check boxes in the Component Selection
dialog box.
4. Start the Audit Configuration application (AuditConfig.exe), enable auditing, and specify
where to store the audit files.
Note: Ensure that the directory location for your log files is write-enabled
5. Start Impromptu.
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6. Open a report and make some general changes to create some events in your log files.
7. Close Impromptu.
8. Start the Audit File Processor application (AuditFileProcessor.exe), process the audit files,
and store their data in the database file you created in step 2.
9. Start Impromptu and create a database definition using the data source you created in step
1.
10. Create a catalog using the database definition you created in the previous step.
11. Create your report or use one of the sample auditing reports.
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What is SQL?
SQL, or Structured Query Language, is the standard query language for accessing information
from relational databases. You do not need to know SQL to use Impromptu, since Impromptu
automatically generates the SQL needed to retrieve data for your reports.

What You Can Do
Impromptu generates SQL statements for your reports and queries. You can view and alter
existing SQL statements or you can write SQL statements from scratch. You can also insert
SQL statements that are extracted from other applications that use non-standard SQL. This is
not recommended since many Impromptu features are no longer available when you manually
enter SQL code.
Once you alter the SQL statements, you can only change the query by manually editing the SQL
statement.

What You Cannot Do
Once you edit SQL statements, you cannot
• access some Impromptu tabs (for example, Data, Sort, and Filter). The remaining tabs
provide only limited functionality
• access some of the toolbar buttons (for example, Sort, Filter, and Snapshot)
• re-establish most of the governor settings that control permissions
• schedule reports to be executed on a remote server

Related Topics
•
•
•
•

"Change a Query By Writing Your Own SQL" (p. 86)
"Create a Query By Writing Your Own SQL" (p. 86)
"Generate Efficient SQL for Summary Level Reports" (p. 87)
"View the Existing SQL for the Query" (p. 85)

View the Existing SQL for the Query
Description
You can view existing SQL for a query.

Steps
1. From the Report menu, click Query, and then click the Profile tab.
2. Click the SQL option button to show the SQL code for this query.

Related Topics
•
•
•
•

"Change a Query By Writing Your Own SQL" (p. 86)
"Create a Query By Writing Your Own SQL" (p. 86)
"Generate Efficient SQL for Summary Level Reports" (p. 87)
"Use SQL" (p. 85)
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Create a Query By Writing Your Own SQL
Description
You can create a query by writing your own SQL.

Steps
1. Create a new report using a template.
The Query dialog box appears.
2. Click the Profile tab.
3. Click the SQL option button.
Note: The SQL option button only appears if the administrator has enabled SQL access for
you.
4. Click Edit.
5. In the SQL Query tab, create a SQL statement, and click OK.

Related Topics
•
•
•
•

"Change a Query By Writing Your Own SQL" (p. 86)
"Generate Efficient SQL for Summary Level Reports" (p. 87)
"Use SQL" (p. 85)
"View the Existing SQL for the Query" (p. 85)

Change a Query By Writing Your Own SQL
Description
You can change a query by modifying the SQL statements.

Example
You change a calculation or filter by directly altering the SQL statements.

Steps
1. From the Report menu, click Query, and then click the Profile tab.
2. Click the SQL option button.
3. Click Edit.
4. Click where you want to modify the SQL statements and then do one of the following:
•

To add your own SQL, type the SQL.

•

To paste copied SQL statements, click Paste.

• To create prompts, click the Insert Prompt.
Note: If you want to maintain the report layout, you must use the same data item name
references Impromptu has assigned.
5. Click Verify for Impromptu to verify the functionality of the new or existing SQL statements.
6. Click OK.

Related Topics
•
•
•
•
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Generate Efficient SQL for Summary Level Reports
Description
Impromptu can efficiently execute the common summary report.

Steps
1. Group the query on the column for which you want to view summary values (for example, by
CUSTOMER).
2. Associate all related columns to the column you grouped in step 1.
3. Use the summary functions to add the summary columns to the report.
Note: In the Query dialog box, click the Eliminate Duplicate Rows check box to set select
distinct for your query.

Example 1
As shown in the following query, Impromptu varies the join specification in the bottom-most
derived tables to reduce joins and suppress duplicate records. The query groups on the
Order_no column (c9) and associates all related columns to Order_no, Customer name (c13),
Address (c12), City (c11), and Province/State (c10). The select distinct for the Outlet and the
association of the related columns means that no processing is done on the computer, and all
the grouping and sorting is performed by the database.
select c9 as c1,
c13 as c2,
c12 as c3,
c11 as c4,
c10 as c5,
c8 as c6
from
(select T1."ORDER_NO" as c7,
SUM(((1 - T4."DISC_PRCNT" / 100) * (T4."PRICE" * T4."QTY"))) as c8
from "CUSTSITE" T3,
"ORDER" T1,
"CUSTOMER" T2,
"ORDRDETL" T4
where ((T3."CUST_NO" = T1."CUST_NO") and (T3."SITE_NO" = T1."SITE_NO")) and
(T2."CUST_NO" = T3."CUST_NO") and (T1."ORDER_NO" = T4."ORDER_NO")
group by T1."ORDER_NO"
) D2,
(select distinct T1."ORDER_NO" as c9,
T3."PROV_STATE" as c10,
T3."CITY" as c11,
T3."ADDRESS1" as c12,
T2."CUSTOMER" as c13
from "CUSTSITE" T3,
"ORDER" T1,
"CUSTOMER" T2
where ((T3."CUST_NO" = T1."CUST_NO") and (T3."SITE_NO" = T1."SITE_NO")) and
(T2."CUST_NO" = T3."CUST_NO")
) D1
where (c9 = c7)
order by c1 asc
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Example 2
The application of this optimization depends on how the query is grouped. For example, if you
group on ORDER.Order_no rather than ORDRDETL.Order_no, the query is not fully optimized.
As a result, an extra server-based join is performed. In this case, instead of the above efficient
version, the bottom-most derived table is constructed as follows:
select distinct c9 as c1,
c13 as c2,
c12 as c3,
c11 as c4,
c10 as c5,
c8 as c6
from
(select T1."ORDER_NO" as c7,
SUM(((1 - T4."DISC_PRCNT" / 100) * (T4."PRICE" * T4."QTY"))) as c8
from "CUSTSITE" T3,
"ORDER" T1,
"CUSTOMER" T2,
"ORDRDETL" T4
where ((T3."CUST_NO" = T1."CUST_NO") and (T3."SITE_NO" = T1."SITE_NO")) and
(T2."CUST_NO" = T3."CUST_NO") and (T1."ORDER_NO" = T4."ORDER_NO")
group by T1."ORDER_NO"
) D2,
(select distinct T1."ORDER_NO" as c9,
T3."PROV_STATE" as c10,
T3."CITY" as c11,
T3."ADDRESS1" as c12,
T2."CUSTOMER" as c13
from "CUSTSITE" T3,
"ORDER" T1,s
"CUSTOMER" T2
where ((T3."CUST_NO" = T1."CUST_NO") and (T3."SITE_NO" = T1."SITE_NO")) and
(T2."CUST_NO" = T3."CUST_NO")
) D1
where (c9 = c7)
order by c1 asc

Example 3
As another example, if you have not associated the Order columns with "Order_no", you must
click the Eliminate Duplicate Rows check box in the Filter tab (Query dialog box). This query
retrieves all sales records to the computer for sorting. The resulting query is inefficient and
returns a large volume of data:
select distinct c9 as c1,
c13 as c2,
c12 as c3,
c11 as c4,
c10 as c5,
XSUM(c14 for c9) as c6
from
(select T1."ORDER_NO" as c9,
T3."PROV_STATE" as c10,
T3."CITY" as c11,
T3."ADDRESS1" as c12,
T2."CUSTOMER" as c13,
((1 - T4."DISC_PRCNT" / 100) * (T4."PRICE" * T4."QTY")) as c14
from "CUSTSITE" T3,
"ORDER" T1,
"CUSTOMER" T2,
"ORDRDETL" T4
where ((T3."CUST_NO" = T1."CUST_NO") and (T3."SITE_NO" = T1."SITE_NO")) and
(T2."CUST_NO" = T3."CUST_NO") and (T1."ORDER_NO" = T4."ORDER_NO")
) D1
order by c1 asc

Related Topics
•
•
•
•
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What is a HotFile?
A HotFile is a local data table you can create from database columns. Once created, a HotFile is
independent of the database columns from which it was created, and you can use it in any
report or catalog. You can join a HotFile to database tables, reports, or other HotFiles.

What You Can Do
You can
• generate reports using data from multiple databases.
You can join information from different databases in heterogeneous database environments,
or in environments where you must query multiple databases simultaneously. For example,
suppose your corporate data is stored in an Oracle database and some of your own
personal data is stored in a personal dBASE database. You can create a HotFile from either
of these databases and then use that HotFile to create reports in conjunction with the other
database.
• use HotFiles as lookup tables or in report prompts.
Reports that query large datasets can slow computer performance when you use them as
lookup tables or in report prompts. For example, if you use report that accesses a large
dataset to filter values in a second report, Impromptu runs the large report and reads
through the dataset to apply the filter. Instead, create a HotFile with the data you want in
your lookup table or prompt, and then use the HotFile in your query.
• use HotFiles as a database.
You can store important reporting data from a corporate database in HotFiles, and then use
these HotFiles as a database that you access in a catalog. This enables you to stage your
data for local queries, without submitting queries to the database.
• add data items to a report not included in your catalog by adding them directly from a
HotFile.
• share HotFiles by including them in your catalog.
• create and use HotFiles for a multiple query report that Impromptu executes in a single
query.
A multiple query report requires more than one query of the data to create the report. For
each individual query in a multiple query report, you can create a HotFile, and then create a
report that queries the HotFiles.

Notes
•
•
•

HotFiles exist on the client. They are not supported by Impromptu Request Server.
HotFiles are not indexed, therefore, joins may take longer than expected to execute.
HotFile size is limited only by available disk space. However, you should not use HotFiles to
store very large query results as they could slow computer performance.
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Related Topics
•
•
•
•
•
•
•
•
•

"Add a HotFile to Your Catalog" (p. 91)
"Change or Update a HotFile" (p. 90)
"Create a Catalog of Only HotFiles" (p. 91)
"Create a HotFile" (p. 90)
"Create and Use a HotFile for a Multiple Query Report" (p. 94)
"Join Multiple Databases Using HotFiles" (p. 93)
"Share HotFiles by Including Them in Your Catalog" (p. 93)
"Use a HotFile in Your Report" (p. 92)
"Use HotFiles as Lookup Tables" (p. 92)

Create a HotFile
Description
You can create a HotFile of a report you want to use separately from your database. You can
use a macro to automatically create a HotFile.

Examples
You have millions of rows in a database and you commonly use 20 of them. You create a HotFile
containing only those 20 rows. This saves processing time when executing queries by reducing
the number of rows in the query.
You have to generate a daily report of the previous day’s sales and the sales table containing the
data item is not in the local database. You use a macro to automatically create a new HotFile
every day.

Steps
1. Create or open the report with the data items you want in your HotFile.
2. From the File menu, click Save As.
3. In the File Name box, type the name for the HotFile.
4. In the Save As Type list, click HotFile (*.ims) and then click Save.

Related Topics
•
•
•
•
•
•

"Add a HotFile to Your Catalog" (p. 91)
"Change or Update a HotFile" (p. 90)
"Create a Catalog of Only HotFiles" (p. 91)
"Use a HotFile in Your Report" (p. 92)
"Use HotFiles as Lookup Tables" (p. 92)
"Work with HotFiles" (p. 89)

Change or Update a HotFile
Description
HotFiles are local tables. After you create a HotFile, you may want to update the data or change
the tables.

Example
You want to create a sales report for July, but you have created a HotFile using June sales
tables. You change or update the HotFile by overwriting the older file.
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Steps
1. Create or open the report containing the data items you want to include in your changed
HotFile.
2. Save your report or query as a HotFile with the same name as the previous HotFile.
3. Click Yes to replace the existing HotFile.
The existing tables and data are overwritten.

Related Topics
•
•
•
•
•

"Add a HotFile to Your Catalog" (p. 91)
"Create a HotFile" (p. 90)
"Use a HotFile in Your Report" (p. 92)
"Use HotFiles as Lookup Tables" (p. 92)
"Work with HotFiles" (p. 89)

Add a HotFile to Your Catalog
Description
You can include a HotFile in your catalog. You can also create a catalog of HotFiles. You need to
create a database definition for the HotFile catalog. For more information, see Create a
Database Definition for a HotFile from the Database Definition Manager online help.

Examples
You have your sales commission conversion table in a separate database. You add the sales
commission conversion table to your commissions catalog using a HotFile.
You notice that everyone in the office is constantly using a specific set of HotFiles. You create a
database definition for those HotFiles to enable easier access.

Steps
1. Close all open reports.
2. From the Catalog menu, click Tables.
3. Click the HotFiles option button.
4. Select the folder containing the HotFile you want and click OK.
The folder’s path appears above the Database Tables box.
5. In the Database Tables box, select the HotFile to add to your catalog, and then click Add.
Note: The HotFile table looks the same as any other table in the catalog.
6. Click OK.

Related Topics
•
•
•
•
•

"Create a Catalog of Only HotFiles" (p. 91)
"Change or Update a HotFile" (p. 90)
"Create a HotFile" (p. 90)
"Use a HotFile in Your Report" (p. 92)
"Work with HotFiles" (p. 89)

Create a Catalog of Only HotFiles
Description
You can create a catalog containing HotFiles only if you have defined a set of HotFiles as a
database. For more information, see Create a Database Definition for a HotFile from the
Database Definition Manager online help. You can add unlimited sets of HotFiles to the catalog.
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Example
All your sales data are in HotFiles. You create a sales catalog containing only those HotFiles.

Steps
1. Create a new catalog.
2. Add the HotFiles to the catalog.

Related Topics
•
•
•
•

"Add a HotFile to Your Catalog" (p. 91)
"Create a HotFile" (p. 90)
"Create a Catalog" (p. 11)
"Work with HotFiles" (p. 89)

Use a HotFile in Your Report
Description
You can use a HotFile in your report.

Example
You want to test a theory that expenses are proportional to salary, and the salary data item is in
a separate database. You create a HotFile with the salary data item to use in your report.

Steps
1. Open a report to obtain the data items you need for your report.
2. From the Report menu, click Query.
3. In the Data Source box, select HotFiles.
4. Click Browse to locate and select the HotFile directory and click OK.
•

In the HotFiles Directory box, double-click the HotFile data items you want to use.

•

Click OK when you have selected all the HotFile data items.

Related Topics
•
•
•
•
•

"Add a HotFile to Your Catalog" (p. 91)
"Create a HotFile" (p. 90)
"Join Multiple Databases Using HotFiles" (p. 93)
"Use HotFiles as Lookup Tables" (p. 92)
"Work with HotFiles" (p. 89)

Use HotFiles as Lookup Tables
Large datasets can slow computer performance when you use them as lookup tables. For
example, if you use a large report as a dataset that filters values in a filter expression,
Impromptu runs the dataset report and then reads through the dataset to apply the filter.
If your data is static, create a HotFile with the data that you want in your lookup table, and then
use the HotFile in your query.

Related Topics
•
•
•
•
•
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Share HotFiles by Including Them in Your Catalog
You can share a HotFile by including it in the catalog. This eliminates the need for your users to
individually add the tables themselves. HotFiles in your catalog appear the same as any data
tables in the catalog. Your users cannot tell the difference between a HotFile table and a regular
database table; the data appears as a part of the catalog.

Example
You are the administrator for a master distributed catalog and several people using this catalog
ask for data on a database you do not normally use. You create a HotFile of the data.

Related Topics
•
•
•
•
•

"Create a Catalog of Only HotFiles" (p. 91)
"Join Multiple Databases Using HotFiles" (p. 93)
"Use a HotFile in Your Report" (p. 92)
"Use HotFiles as Lookup Tables" (p. 92)
"Work with HotFiles" (p. 89)

Join Multiple Databases Using HotFiles
Description
You can use HotFiles to access multiple databases in one query. HotFiles are stored locally and
you must update the HotFiles when you want it to reflect changes to the HotFiles data source.

Example
You want to access a sales table from the corporate Oracle database, and a product table from
a Sybase database. You create a HotFile of the product table and join the HotFile to the
corporate database.

Steps
1. Select one database as the basic database used in Impromptu.
2. Create HotFiles of the tables in any of the other databases.
Note: Use the same folder so that you can access the tables at the same time. You may
want to give alias names to identical tables from different databases.
3. Create a database definition for the HotFiles you create.
4. Create a catalog with the basic database and the HotFiles database.
5. Open the catalog.

Related Topics
•
•
•
•

"Create and Use a HotFile for a Multiple Query Report" (p. 94)
"Share HotFiles by Including Them in Your Catalog" (p. 93)
"Use HotFiles as Lookup Tables" (p. 92)
"Work with HotFiles" (p. 89)
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Create and Use a HotFile for a Multiple Query Report
Description
You can create
• a complex exception report requiring multiple summary filters
For example, if you have to list all your branch offices in descending order of risk, where the
percentage of risky transactions is greater than 50%, you can create a HotFile with a
summary filter to identify risky transactions. You then create another HotFile to eliminate
stable branch offices. Finally, you create a report that separates the unstable branch offices
into several levels of instability. A risky transaction is defined as a transaction with a
potential to result in a loss (negative profitability).
• a statistical analysis report summarizing raw transactional data
For example, if you want to determine the attributes of your best customers, you can create
a HotFile to determine what customer has what attribute. You can then create another
HotFile to determine the factors affecting the attributes. Finally, you can create a report to
rank the customers and show resulting attributes.
• a result set report listing the components of an object
For example, if you want to find all the parts used in a particular model of car, you can
produce an intermediate HotFile by entering your own SQL, and then use the HotFile to
support additional filtering, summaries, and percentages.

Steps
1. Create a HotFile of your first report.
2. Create subsequent HotFiles as necessary.
3. Create a final report.
4. Select the HotFiles that you created in step 1 to include in your catalog.
5. Query the HotFiles.

Related Topics
•
•
•
•
•
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Description
If your catalogs are large and complicated, you may want to store information about the contents
in an external data source; or your company may already store catalog information in a
relational database or metadata repository. You can use that information to provide context help
that describes columns, calculations, catalog filters, and catalog prompts.
Users can open annotations in the Query dialog box, Folders dialog box, and any expression
editor.
You create the annotation server that provides the annotations to the users. An annotation
server receives the annotation request, searches your external data source for information
about the item, and displays the information. You can create the annotation server in any
application that can build a COM server or use the one provided as an example. For more
information about the example annotation server, see "Set Up an Annotation Server Using
Visual Basic" (p. 96). For more information about COM servers, see your Microsoft
documentation.
An annotation request contains two pieces of information, the data item name and fully qualified
folder path, and the database entity that this data item represents. The following table lists
examples of what Impromptu would send to the annotation server for some data items from the
Great Outdoors Sales database.

Annotated item

Data item name and
folder path
Actual database item

City (Column)

\Customer\Customer ColumnRef["OUTDOORS"."CUSTSITE".
Sites\Address\City
"CITY"]

Product Margin
(Calculation)

\Products\Price and ColumnRef["OUTDOORS"."PRODUCT".
Cost\Product Margin "PROD_PRICE"]–
ColumnRef["OUTDOORS"."PRODUCT".
"PROD_COST"]

Active Customers

\Customers\Conditio ColumnRef["OUTDOORS"."CUSTOMER
ns\Active Customer "."STATUS"] = 'A'

(Catalog Filter)
Date(Catalog
Prompt)

\Prompts\Date
(type-in)

Order No.

?\Prompts\Orders\Or FolderItemRef["Prompts"."Orders"."Order
der No. (type-in)? + No. (type-in)"] + 10
10

(Catalog Prompt
used in a
Calculation)

PromptDef["\Prompts\Date
(type-in)","Enter the
Date:",un,0,f,8,f,ti,dt,"1998-03-03"]

Related Topics
•

"Set Up an Annotation Server Using Visual Basic" (p. 96)
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Set Up an Annotation Server Using Visual Basic
Description
Annotations are descriptions of columns, calculations, catalog filters, and catalog prompts
stored in a relational database or metadata repository. You create an annotation server to
provide those annotations to your users. Creating the annotation server using C++ is more work
than using Visual Basic because you must create an ActiveX server that supports the interface
specified in the Steps tab.
A compiled annotation server (AnnotationServer.exe) and an annotation database file
(Annotate.mdb) are included in the Impromptu samples.

Steps
1. Open Visual Basic and select the ActiveX.exe project.
2. Open the Project Explorer window.
3. Set the Project Name to AnnotationServer.
4. Add new class called Annotate or rename Class1 to Annotate.
5. Add a function called AnnotateRequest to Annotate by pasting the following code in the
(General) code window:
Public Sub AnnotateRequest(folder As String, dB As String)
'Configure the dialog box
AnnotateResults.folder = folder
AnnotateResults.dB = dB
'Show the dialog box
AnnotateResults.Show
End Sub

6. Create a form to display the annotation.
7. From the File menu, click Make AnnotationServer.exe to compile the executable file.
8. Click Run and then click Stop.
9. Distribute the AnnotationServer.exe to users.
10. Have your users register AnnotationServer.exe to their computers.
Tip: You could write a batch file (.bat) that registers AnnotationServer.exe for your users.
After being registered, users can open Impromptu and request annotations.

Related Topics
•
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You can use the Stored Procedure.imt template to create reports that call stored procedures and
show the results in a simple list report. Stored procedures are routines of code stored in a
database. You must create a prompt for each input and output parameter.
Because you type a stored procedure call, your stored procedure report has the same
limitations as other type-in queries. For more information, see "Use SQL" (p. 85).
Rather than sort, group, or filter the stored procedure report directly, you use the report as a
data source for other reports. You can save the report and reuse the columns in other reports
created from the same catalog. For more information about re-using reports, see Use a Report
in Another Report in the Impromptu User online help. You can also add the stored procedure
report to the catalog using the Tables dialog box and then join this report to other reports or
tables from the database.
Reusing reports need not be limited to stored procedures; you can reuse any report (except
crosstabs) in another report. If you reuse a report in another, then the result set of the reused
report has to be locally cached when you execute the final report. This may increase processing
time.
Impromptu supports stored procedures where the database supports stored procedures. For
information about supported databases and versions, see the Cognos Support Web site
(http://support.cognos.com).
You can create stored procedure reports in either administrator or user versions of Impromptu,
provided that the user class that you used to attach to the catalog permits you to edit SQL. To
allow SQL editing, select the Direct Entry SQL check box from the Governor tab of the User
Profiles dialog box.
Any user class that can create and edit reports can reuse a stored procedure report in another
report, using either version of Impromptu.
Tip: To allow your users to create and edit reports, select the Create/Edit Reports check box in
the Governor tab of the User Profiles dialog box.

Notes
•
•
•
•

You can still add formats, borders, and patterns to the stored procedure report.
You can't save a stored procedure report as an .iqd file.
Use uppercase to specify the name of an ORACLE stored procedure.
By default, prompts are single select. A Type In prompt response could contain multiple,
comma-separated values, but it would require the stored procedure to parse it.

Related Topics
•
•
•

"Create a Stored Procedure Report" (p. 97)
"Hide Prompts from Users" (p. 99)
"Insert Parameters in a Stored Procedure Call" (p. 98)

Create a Stored Procedure Report
Description
Stored procedures are routines of code stored in a database. Among other capabilities, a stored
procedure can retrieve data. A Stored Procedure.imt template is provided to assist you in
creating stored procedure reports.
An example of a stored procedure is:
call range_sp1 ( ?ParamStartDate? IN, ?ParamEndDate? IN )
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Stored procedures have the following components:
Syntax

Explanation

<procedure_name>

The name of the procedure. Type either the
name or fully qualified name, for example,
catalog.schema.proc_name.

<parameter>

A prompt that provides the parameter. The
name should indicate its purpose ("DATE").
Append the parameter type (one of: "IN",
"OUT" or "IN OUT") after the prompt name.
This component is optional, although most
stored procedures have parameters.

<status>

A prompt that returns a status value.
This component is optional. Except for
Sybase, most stored procedures won't return
a status.

Steps
1. From the File menu, click New.
2. Select the Stored Procedure template (Stored Procedure.imt) and click OK.
If you do not have a catalog already open, the Open Catalog dialog box appears for you to
select the catalog to use.
The SQL tab of the Stored Procedure dialog box appears.
3. Type the name of the stored procedure.
Note: Use uppercase to specify the name of an ORACLE stored procedure.
4. Click Insert Parameters to add a parameter.
5. Create a prompt for each input and output parameter.
Note: You may have to insert "IN", "OUT" or "INOUT" and a comma between parameters.
6. Click Verify to test the SQL syntax.
7. If the SQL syntax is OK, click OK.
Otherwise, fix your SQL syntax and click Verify again.
8. Save the report as an Impromptu report (.imr), not as a HotFile (.ims).
9. Use your report in another report.

Related Topics
•
•
•

"Hide Prompts from Users" (p. 99)
"Insert Parameters in a Stored Procedure Call" (p. 98)
"Work with Stored Procedures" (p. 97)

Insert Parameters in a Stored Procedure Call
Description
In Impromptu 7.0, you use prompts to specify values for all input and output parameters. You
specify constant values directly in a stored procedure by providing a default value for a prompt
and setting that Impromptu not to prompt the user for those values by selecting the Use The
Default Value check box in the Prompt Definition dialog box. Although you are required to use
prompts to specify the output parameter values, those values are only placeholders required for
syntax checking. The output parameter values have no impact on the stored procedure
execution. Input parameters are available for use within the stored procedure and are used for
prompting users for value required during query execution.
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For example, if a stored procedure called dba.MyStoredProc takes an employee number
(integer) and the department name (string) as input, then you cannot make a call to the stored
procedure as shown below:
call dba.MyStoredProc(100, "HR")

You first have to define two prompts (because there are two input parameters), for example
EmpNo (datatype: integer) and Dept (datatype: string) with 100 and HR as default values for the
prompts.
call dba.MyStoredProc(?EmpNo?, ?Dept?)

Impromptu is able to access the first result from a stored procedure. Subsequent results are not
available within Impromptu. If you want the output parameters returned with the result set, list
them in the Select statement. This may not work for all databases.
In the example listed below, X and Y are output parameters and are returned with the result set.
PROCEDURE QCSP_PARM_REF (RESULT1 IN OUT ACCTCURTYPE,
X OUT NUMBER,
Y IN OUT CHAR,
Z IN NUMBER,
RESULT2 IN OUT B_S_CURTYPE1) is
BEGIN
X := 1;
Y := 'Y';
OPEN RESULT1 FOR
SELECT *, X, Y, Z FROM ACCT WHERE ACCT.ACCT_CD = Z;
OPEN RESULT2 FOR
select bill_sum_key, trn_proj_id, acct_id, org_id
from BILLING_SUM;
END;

Steps
1. Position the pointer where you want the prompt.
2. Click the Insert Prompt button to open the Prompt Manager dialog box.
3. In the Available Prompts box, if the prompt already exists, click the prompt and then click
OK. Otherwise, click New and define the prompt in the Prompt Definition dialog box.

Related Topics
•
•
•
•

"Create a Stored Procedure Report" (p. 97)
"Hide Prompts from Users" (p. 99)
"Work with Prompts" (p. 57)
"Work with Stored Procedures" (p. 97)

Hide Prompts from Users
Description
In some circumstances, you may want to hide a prompt from a user when providing constant
parameters to a stored procedure or when output parameters, for which an input value is
meaningless, will be overwritten.

Steps
1. Open the stored procedure report.
2. From the Report menu, click Prompt Manager.
3. In the Available Prompts box, click the prompt to hide.
4. Click Edit.
5. Click Advanced.
6. Select the Use the Default Value check box and click OK twice.
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Related Topics
•
•
•
•
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aggregate
A calculation involving a summary component and a FOR clause indicating for what group the
aggregate is calculated. An aggregate is calculated independently of its position in a report and
of its association with a group. You can perform the following aggregates: total, minimum,
maximum, average, count, rank, percentile, percentage, running-total, running minimum,
running maximum, running average, running count, and standard deviation. Also called a
summary.

alias
An alternative label for a table. Create an alias to relate values in a single table by creating a
self-join between the table and its alias. For example, you can determine the name of each
employee’s manager if an employee table contains the employee name, employee number, and
manager number. You can also use a filter expression on the alias to create a view of part of the
data from the original table; for example, all those employees who report to a particular
manager.

annotations
Descriptive information about the contents of your catalogs. You can develop an application that
shows the annotations when your users want context-sensitive help about your catalog folders,
columns, prompts, filters, and calculations.

Architect model
The information required to author a set of Cognos applications, contained in a single file (.rep).
The Architect model describes an enterprise reporting and querying environment that uses one
or more metadata sources.

associated data item
A data item linked to the group data item. Associated data items suppress duplicate data values,
but do not generate a control break. For example, if Customer Number is the grouped data item,
you can repress Customer Name by declaring it as an associated data item. When Customer
Number appears in the report, it appears only once for the group. Marking a data item as
associated can affect how Impromptu calculates summary values.

auditing
The process of recording performance information and using it to find out how changes to your
reporting environment affect performance times. To audit performance in Impromptu use the
Audit Configuration and Audit File Processor applications.

automatic association
The group association of a newly created summary. The location of the group where you create
the summary determines its automatic association. If you create a summary using the Calculate
button in the Data tab (Query dialog box), the summary appears at the bottom of the Group
Order box until you run the query. After you run the query, the summary appears under the
lowest group in the Group Order box. If you move a summary with automatic association to a
new location in the report, it appears under the group representing the new location.
See also summary.

automation
See OLE automation.
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bitmap
An image that consists of pixels on the screen and, stored as a collection of bits. Windows
bitmaps have the extension .bmp.

BLOB
A Binary Large Object, or large unstructured object stored in the database. A BLOB can be free
text, images, digitized images, or audio streams.

boundary line
A line that indicates the extent of a frame as well as names of each report object. You show or
hide boundary lines by using the Boundary Line command (View menu).

bulk fetch
Retrieval of more than one row of data from your database in a single fetch call. Bulk fetch can
improve processing time for large queries.

cache query
A temporary cache on your personal computer that Impromptu uses to store report results. You
set the cache query by clicking Query from the Report menu, and then clicking the Access tab.

calculated data item
A data item that shows the result of an expression that uses stored data. The value recalculates
each time a value in the expression changes. For example, you can use the string operator (+)
to combine a data item called Firstname with a data item called Lastname to form a calculated
data item called Fullname.

cascading prompt
A prompt that uses information from a previous prompt to determine which options to display in
a picklist.

catalog
A file (with the extension .cat) that contains all the information necessary for Impromptu to
access and retrieve information from a relational database. A catalog does not store data, but it
does provide Impromptu with a business view of the data. A catalog also contains information
about what database to access, where the database is stored, and how the tables in the catalog
are joined.
See also personal catalog, shared catalog, and secured catalog.

catalog condition
An expression that can be used anywhere you need a true-false value. A catalog condition is
stored in the catalog. You can use conditions in filters, in conditional formatting, and in
calculations. For example, you can use a condition to see data for only your sales region.

catalog prompt
A prompt you store in the catalog that you can re-use in different reports.

cell
The intersection of a column and row that contains a single value.

chart frame
A type of frame that provides a visual image of numeric report data. Charts can be formatted in
a number of ways, including bar charts, area charts, pie charts, bubble charts, and many other
popular formats.
See also child frame, parent frame, primary frame, and report object.

102 Impromptu (R)

Glossary

child frame
A frame or report object that is subordinate to a parent frame.
See also primary frame and report object.

CognosScript
A language similar to VISUAL BASIC, that is included with Cognos applications. You can use
CognosScript to write macros.

Color Dialog Box
Displays a color palette. Use to apply color to report objects, such as fonts, charts, lines, borders
and grids. The display settings on your computer determine the colors available.

column
One kind of information in a list frame, it is a vertical list of data that shares the same definition.

column spacer
Enables you to create an empty space between list frame columns.

comma delimited ASCII file
A text file where each column of data is separated from the next by a comma. All data must use
ASCII standard characters.

command line
The characters used to start an application. For example, you enter command line parameters
when you start Impromptu by clicking Run from the Start menu and typing a command.

complex join
A complex join uses an expression to join two tables. You must click the Expression option
button to create a complex join.

compound join
A compound join is a join containing several columns joining two tables. A compound join can be
an equi-join, non-equi-join, outer join, self-join, or complex join.

condition
An expression that can be used anywhere you need a true-false value. A condition can be
stored in the catalog. You can use conditions in filters, in conditional formatting, and in
calculations. For example, you can use a condition to see only data for your sales region.
See also filter.

conditional format
An instruction to Impromptu to look through data in the selected report objects and format the
data that meets predefined conditions. Use this format to identify exceptional data in your report.
For example, retail outlets with quarterly revenues greater than $500,000 could be highlighted in
green, while retail outlets with quarterly revenues less than $250,000 could be highlighted in
red.

control break
The start of a new group of data, which allows operations such as subtotaling.

Creator
The user class who creates a catalog and usually administers it. By default, the creator has no
restrictions on using the catalog.
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cross-product query
A report that retrieves data from tables that do not have table joins defined for them.

crosstab
Shows summary information from a list report in a compact table of rows and columns. A
crosstab shows the value for the combination of each row and column, enabling you to gain a
different perspective on the data and see more without the need to scroll.
For example, you can change a list report that has three columns (Product Type, Sales Channel,
Total Sale Amount) into a crosstab that has each Product Type as a row, each Sales Channel as
a column, and the Total Sale Amount for each combination of Product Type and Sales Channel
in the cells.

crosstab detail filter
Use to filter on the detail columns generated in a crosstab report. For example, if you add the
Product Type data item to the rows, you can apply a crosstab detail filter to Environmental Line,
GO Sport Line, or Outdoor Products.
See also detail filter and crosstab summary filter.

crosstab summary filter
Use to filter on the summary columns generated in a crosstab report. For example, you can filter
on the row totals in a crosstab to show only data items with a total product cost that is over 300.
See also summary filter and crosstab detail filter.

custom condition
An expression that has a true-false value that you use when conditionally formatting report data.
For example, you can define a condition that highlights sales margins less than 50%.
You create a custom condition in a report.

data item
A column from a database, HotFile table, or a snapshot of a report.

data source
Where Impromptu retrieves information for your query. The data source can be a database,
HotFile, snapshot, or thumbnail.

data type
One of six data types in Impromptu: character, date, date-time, numeric, time, and interval.

database
A collection of data related to a particular purpose and organized for ease of reference.
Depending on the type of database you are using, a database can contain tables, views,
synonyms, and stored procedures.

dataset
An Impromptu report that stores data values you can use when applying a filter. A dataset is
dynamic, meaning that when you use a dataset in a filter, the report that stores that dataset is
re-run.

date_exp
A date constant, a date data item, or any expression resulting in a date value.

datetime_exp
A date constant, a date data item, or any expression resulting in a datetime value.
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detail filter
Limits the data retrieved in a report. A detail filter eliminates data from a report by restricting the
data. For example, you could create a detail filter to specify that only sales over $1000 be
included in the report. It is the only filter choice if you have not created a summary calculation for
a report.
See also summary filter.

Device Independent Bitmap (DIB)
A bitmap that contains a color table describing how the pixel values correspond to RGB color
values.

directory server
Specialized databases that store user attributes, object classes and other schema-type
information in a hierarchical format.

distributed catalog
A catalog intended for a workgroup or company where several users need to
• create and edit reports
• change the catalog contents
For example, users can move and rename folders.
• work offline with Impromptu
For example, users can take their copy of the catalog along on a business trip.
When users open a distributed catalog, Impromptu makes a personal distributed catalog on the
user's personal computer. However, Impromptu maintains a link with the master distributed
catalog so that if any changes are made to the original, each user's copy is updated
automatically.

drill through
An action that enables Impromptu, PowerPlay, and Scenario users to view transaction-level
details in an Impromptu report. You can set up a drill through for any cell in Impromptu, any
value in PowerPlay, or any node in Scenario’s tree view.

dynamo
Formats the result of an SQL query against an ODBC data source. You use a dynamo to
generate HTML controls that are placed on a page of a PowerPrompts application. For example,
you can create a dynamo that retrieves countries from a data source. The same dynamo may
contain different countries, depending on what is contained in the data source or as the data
source is updated.

embed
Inserts information created in one application into another application. Once embedded the
information, called an object, becomes part of the document in which it is embedded. When you
double-click an embedded object, you open the application in which the object was created
where you can edit the object.
You can embed objects in an Impromptu report or you can embed Impromptu report into another
application.
See also link and OLE (Object Linking and Embedding).

equi-join
A type of join that retrieves all the rows from one table that have matching rows in another table.
See also non-equi-join, outer join, and self-join.

expression
Any combination of operators, constants, functions, data items, and other components that
evaluates to a single value.
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expression editor
A dialog box or tab where you can create or edit an expression, including the following:
• Calculation Definition dialog box (Data tab Query dialog box)
• Data Definition dialog box (Data tab Query dialog box)
• Edit Calculation dialog box (Folders dialog box)
• Edit Condition dialog box (Folders dialog box)
• Filter tab (Query dialog box)
• New Calculation dialog box (Folders command Catalog menu)
• New Condition dialog box (Folders command Catalog menu)
• User Filter Profile dialog box (Filter tab User Profiles dialog box)

extension
Three characters that follow a file name. The following extensions are used by Impromptu:
• .bmp
Windows bitmaps
• .cat
Impromptu Catalogs
• .cq
Cognos Query file
• .csv
Comma delimited ASCII files
• .dat
data file used to source PowerPlay reports
• .dbf
dBASE files
• .dib
Device Independent Bitmaps
• .htm
Hypertext Markup Language files
• .icr
Impromptu Catalog content reports
• .imb
Impromptu Template bitmaps
• .imr
Impromptu Reports
• .ims
Impromptu HotFiles
• .imt
Impromptu Report Templates
• .iqd
Impromptu Query Definition files
• .mac
Cognos Macros
• .mcx
Compiled Cognos macros
• .pdf
Adobe Portable Document Format
• .sql
Structured Query Language (SQL) files
• .tmp
Temporary files
• .txt
Text files
• .wk1
Lotus 1-2-3 files
• .wmf
Windows metafile graphic
• .xls
Microsoft Excel files
• .xml
Extensible Markup Language files

filter
A set of criteria used to retrieve a specific subset of records for your report. You can use a filter
in reports to filter out unnecessary data and highlight the most important information in your
report. For example, you can use a filter that shows only the data for your sales region.
If you are using Impromptu Administrator Version, you can create a filter for a user class that is
automatically applied when the user class accesses the table or column specified in the filter.
For example, you can create a filter on the Salary table so that only the Human Resources
department can view that table. All other user classes will not see the Salary table.
See also detail filter, summary filter, and condition.

fixed association
A group association entered into the definition of a summary data item. Unlike an automatic
association, the fixed association remains the same when you move it to a new location.
See also associated data item.
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footer
A free-format area that appears at the bottom of a list frame or below a specific portion of a list
frame.
See also header.

form frame
A type of frame that serves as a free-format container for other frames and report objects,
Forms are useful when creating reports that require custom placement of data, text, tables, and
other report objects. A form frame shows one row, or record, at a time.
See also child frame, parent frame, primary frame, and report object.

format symbol
Tells Impromptu how to show the data value. For example, the numeric format # symbol shows a
single digit.

Format Toolbar

A bar with buttons and options you can use to format selected report objects.
See also toolbar and Toolbar button.

frame
A report object that acts as a container for other report objects. Frames are the basic building
block with which you create Impromptu reports.
See also chart frame, child frame, form frame, list frame, parent frame, picture frame, primary
frame, and text frame.

function
A function is a predefined calculation that takes one or more values, performs an operation, and
returns a value. There are three kinds of functions in Impromptu: Impromptu functions,
Database functions, and User-Defined Functions.

General format
A standard format that displays data as follows.
Data

displayed...

Numbers

with no symbols.

Alphabetical/Alphanumeric
data

with an initial capital letter.

Dates

in the MM/DD/YY format.

Date-Time

in the MM/DD/YY HH:MM am/pm
format.

Intervals

in the D HH:MM:SS.SSS format.

group data item
A control data item that is used to group data in a report.
See also associated data item.

header
A free-format area that appears at the top of a list frame or above a specific portion of a list
frame.
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See also footer.

HotFile
A separate local data table that can be added to your catalog or used in a report as if it were a
regular database table. Once you create a HotFile, any report or catalog can use it. You can use
a HotFile to link to any database. For example, you can use HotFiles to compare this month’s
data with last month’s data.

HTML
Hypertext Markup Language. HTML is the language used to create documents for the World
Wide Web.

integer_exp
An integer constant, an integer data item, or any expression (including a numeric_exp) resulting
in an integer value.

intranet
A computer network found within an organization that provides services similar to those found
on the Internet but on a smaller scale.

interval_exp
An interval constant, an interval data item, or any expression resulting in an interval value.

join
Defines the relational links between tables in the physical database. These joins enable you to
relate the data in one table to the data in another table in the same database so that you can
retrieve data from more than one table at a time. You join tables using columns in tables. For
example, the Customer table and the Sales table can be joined using the Cust column.
See also equi-join, non-equi-join, outer join, and self-join.

key
Keys are used to uniquely identify each record in a table. Keys are also used to make joins
between tables. For example, Cust-id is the key of the Customer table because there can only
be one customer ID for each customer.

Layout Toolbar
A bar with buttons and options you can use to work with report objects.
See also toolbar and Toolbar button.

LDAP (Lightweight Directory Access Protocol)
A product-independent protocol that is used to locate organizations, individuals, files, and other
resources on the Internet or a corporate Intranet.

link
The connection between a linked object and the application in which it was created. When the
information changes in the source file, the changes are reflected in the destination file. You can
choose to update linked information manually or automatically.
See also embed and OLE (Object Linking and Embedding).

list frame
A type of frame that is designed to report tabular data in rows and columns. Each column in a
list frame shows all the values for a data item in the database or a calculation based on data
items in the database.
See also child frame, parent frame, primary frame, and report object.
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macro
A customized sequence of instructions ("macro commands") that Cognos’ applications can
carry out.

marked for insertion
A data item that appears in the report. This icon appears beside the data in the Data tab item
(Query dialog box). Data items can be included in the query and not be marked for insertion in
the report.

master distributed catalog
Intended for a workgroup or company where several users need to create and edit reports by
using a common source of information. Only the Creator class can modify or change the master
distributed catalog.
When users first open a master distributed catalog, Impromptu makes a copy of the master
distributed catalog on the user’s personal computer. This local copy is called a personal
distributed catalog, and allows users to move and rename folders, and work off-line with
Impromptu.
Impromptu maintains links between master distributed catalogs and personal distributed
catalogs, and automatically updates these personal distributed catalogs whenever changes are
made to the master distributed catalog.
See also catalog, personal catalog, shared catalog, secured catalog, and source catalog.

measure
In PowerPlay, the numbers by which you gauge the performance of your organization. For
example, measures can be Revenue, Revenue/Employee, and Profit Margin %.

metacharacter
A character used in pattern matching, such as asterisk (*), at-sign (@), caret (^), exclamation (!),
left angle bracket (<), or-bar (|), parentheses ( () ), pound (#), question mark (?), right angle
bracket (>), or slash (\).

metadata
Information about the catalogs, schemas, tables, and columns in the database.

metafile
An image that is generated by the calculation of position on the screen. It can produce more
intricate images than a bitmap. Windows metafiles have the extension .wmf.

namespace
A source of authentication data used by Access Manager that exists as a directory on a
directory server, or as an entry in a local authentication export (.lae) file, depending on the
default security server configured in the system registry.
The security data stored in each namespace, such as signon information for users, user
classes, application servers and data sources, distinguishes each entry from all other
namespaces in the repository.

nested crosstab
A crosstab report that contains more than one data item in the rows or columns. For example,
you can nest Product Type and Product Line beside each other in the rows.

non-equi-join
A type of join that retrieves all the rows from one table that meet the criteria in another table. For
example, for each product, you can list the active accounts that have not purchased a product
using the not equal to (<>) operator.
See also equi-join, outer join, and self-join.
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numeric_exp
A numeric constant, a numeric data item, or any expression resulting in a numeric value.

object
Any piece of information that you create and edit, often with an application other than
Impromptu, and then insert and store in an Impromptu report.

ODBC (Open Database Connectivity)
A Microsoft vendor neutral interface between database management systems (DBMS) from
multiple vendors. It is based on existing standards from the SQL Access Group (SAG), X\Open,
and ANSI.

ODBC driver
A dynamic-link library (DLL) that an ODBC-enabled application, such as Impromptu, can use to
gain access to a particular data source. Each database management system (DBMS), such as
dBASE, requires a different driver.

OLE (Object Linking and Embedding)
A Microsoft Windows facility that enables applications to share data. When you use OLE, two
applications can share data through a connection that you establish.
See also link and embed.

OLE automation
An industry standard that allows applications to expose OLE objects to development tools,
macro languages, and other applications that support the standard. With OLE automation, you
can work in one application from within another application.

ownership collection
A collection whose elements (objects) are dependent on the collection's parent. For example,
the Column objects in the Columns collection are dependent on the parent Table object. If the
Table object is deleted, the Column objects in the Columns collection are also deleted.
See also reference collection.

operator
Specifies what happens to the values on either side of the operator.
There are four types of operators:
• Logical: defines relationships between two parts of the expression.
• Arithmetic: performs arithmetic operations on two parts of an expression.
• String: concatenates two character strings.
• Comparison: compares one or more values that you enter against the values in the
database.

outer join
A type of join that retrieves rows from one table even if the rows in another table do not match.
You can use the following kinds of outer joins:
• A left outer join includes all rows from Table A, matched or not, plus the matching values
from Table B.
• A right outer join includes all rows from Table B, matched or not, plus the matching values
from Table A.
• A full outer join includes all rows from both tables, merged where matches were found.
See also equi-join, non-equi-join, and self-join.
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parent filter
A filter created for the parent user class of the selected user class. For example, a user class
called Employees is based on the user class called Managers. In this case, the Managers user
class is the parent user class. If you create a filter for Managers, it is automatically applied to
Employees. The filter for Managers is a parent filter for Employees.

parent frame
A frame that contains one or more subordinate frames or report objects.
See also child frame, primary frame, and report object.

percentile
The value on a scale of one hundred that indicates the percent of a distribution that is equal to or
below it.

personal catalog
Intended for the small business owner who wants to maintain data such as personal information,
customer lists, and product pricing. Use a personal catalog if you are the only person using the
catalog and you are using the Administrator Version of Impromptu.
See also catalog, distributed catalog, shared catalog, and secured catalog.

personal distributed catalog
Personal distributed catalogs exist on the user's personal computer, and are copies of the
master distributed catalog. They are created the first time the user attempts to use a master
distributed catalog. Users can work off-line with their personal distributed catalogs. They can
also modify their personal distributed catalogs by moving and renaming folders. However, they
cannot change the tables, columns, or joins that are defined for the distributed catalog.
Impromptu maintains links between the master distributed catalogs and personal distributed
catalogs, and automatically updates the personal distributed catalogs whenever changes are
made to the master distributed catalog.
See also catalog, personal catalog, shared catalog, secured catalog, and source catalog.

picture
Any Windows bitmap file (.bmp) or Device Independent Bitmap (DIB) file that is stored in a
location your computer can access.

picture frame
A frame that you can use to show a bitmap (.bmp) or Device Independent Bitmap (DIB). You
can enhance the appearance of your reports by adding images such as a company logo. In
addition, you can show pictures, such as your company’s products or employees, that change
based on the content for the items.
See also child frame, parent frame, primary frame, and report object.

pivot
A quick way to change a list report into a crosstab report. Pivot by dragging and dropping one or
more columns into the row titles area.

placeholder
A representation of what data should appear in place of the placeholder. Placeholders
determine where and how the data and calculations will be positioned and shown in reports that
use the template. Placeholders can be defined as optional or required. Placeholders can also be
defined to accept one column or many columns. For example, you can add placeholders to a
template that represent the customer’s address in a report. This helps other users understand
how to complete the report.
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PowerCube
A file that contains data that is structured to provide for fast retrieval and exploration in
PowerPlay.

PowerPrompts
A series of HTML forms that Impromptu Web Reports consumers use to customize a report
before they run it. The Impromptu report author creates a PowerPrompts application using the
PowerPrompts Developer Studio, then delivers the application along with the report to the
Impromptu Web Reports administrator.

prompt
A dialog box that asks the user to enter information when a report is opened. A report can
contain several prompts which it uses to filter so you only get the data you want. Prompts can
require the user to type in information, or select items from a picklist. A picklist can include data
items from the catalog, data items from another report, or data from a file in delimited ASCII
format.
See also Prompt Manager.

Prompt Manager
The dialog box you use to create, edit, delete, and store prompts for the currently active report.

prompt references
Prompt references are expressions such as detail filters, summary filters, calculations, and
conditional format expressions that reference a prompt.

primary frame
A frame that serves as the default object into which Impromptu inserts report objects such as
placeholders and data. The first form frame or list frame that is created in a report or template is
automatically designated as the primary frame.
See also chart frame, child frame, form frame, list frame, parent frame, picture frame, report
object, and text frame.

property
A named attribute of an object.

query
A question to the database, snapshot, or HotFile that defines what data you want to retrieve
from the data source.

record
Composed of one data value from each column in the dataset. Also known as a row.

reference collection
A collection whose elements (objects) are not dependent on the collection's parent, they are
only referenced from a collection that the objects are depended on. For example, the Table
objects in the FilteredTables collection are not dependent on the parent UserClass object. If the
UserClass object is deleted, the Table objects in the FilteredTables do not cease to exist
because the collection that the Table objects depend on still exists.
An object cannot only belong to a reference collection, although it can belong to more than one
reference collection. It must also belong to an ownership collection.
See also ownership collection.

relational database
A collection of information that is organized into tables.

112 Impromptu (R)

Glossary

report
A view of the current data in your company database that is organized and formatted the way
you want it. The data you see in your report depends on the data you can access from your
catalog. A report can be based on a template.
See also template.

report author
An Impromptu user who creates complex reports and has an in-depth knowledge of the
powerful features in Impromptu. The Mastering Impromptu Reports online help file is intended
for report authors.

report creator
An Impromptu user who creates basic reports using the Report Wizard or a template, and
applies essential skills, such as sorting, grouping, formatting, and basic filtering. Report creators
can find the information they need in the Impromptu online Help.

report definition
A definition of the data in the report and how the data is shown and formatted. The report
definition is static; it does not change when the report data changes. The database provides you
with access to the most current data in the database. Therefore, when you save a report, you
are not saving the actual data in your report, only the report itself. To save the report data,
create a snapshot, create a HotFile, or use the Save As command to move the data to an
external file in a specified format (for example, Microsoft Excel or Lotus 1-2-3). You can also
print the report using the Print command to save a copy of its current data.

Report Navigator
An optional control in a HyperText Markup Language (HTML) report. It enables you to jump to a
grouped column value or a specific page number in the HTML report.

report object
An object in a report. Report objects include text, pictures, frames, data items, report variables
such as Date and Page Number, and so on. You can format report objects using the Format
menu commands.

report variable
A value that is supplied by your computer or by Impromptu. Report variables are inserted into
reports using the More Objects command from the Insert menu.

report viewer
An Impromptu user who views reports, prints reports, or exports information found in existing
reports. Report viewers can find the information they need in the Impromptu online Help and the
Discovering PowerPlay book.

result set
A copy of the data retrieved by a report. A result set can be stored locally on a personal
computer, or remotely on a server.

row
Composed of one data value from each column in the database. Also known as a record.

running-average
A summary that displays a new average for each additional value in a selected data item.

running-count
A summary that counts each value in a selected data item one by one.
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running-maximum
A summary that displays a new maximum for each additional value in a selected data item.

running-minimum
A summary that displays a new minimum for each additional value in a selected data item.

running-total
A summary that displays a new total for each additional value in a selected data item.

scope of data
A property of form frames that determines what data they can show. A form frame can show a
single row of data, all rows associated with the grouped data item, or all data the form frame can
access.

secured catalog
Intended for users who do not need or want to create or edit their own reports. The users cannot
change the catalog in any way. They can run, export, and print reports that the administrator has
created. This type of catalog is useful for users who are not familiar with Impromptu and just
want to analyze the data in the pre-defined reports.
See also catalog, distributed catalog, personal catalog, and shared catalog.

self-join
A type of join that enables you to add two copies of the same table to a catalog so that you can
relate values within a single table.
See also equi-join, outer join, and non-equi-join.

shared catalog
Intended for a workgroup or company where several users need to create and edit their own
reports. A shared catalog is ideal in a LAN environment where the catalog can be stored in a
shared drive and directory that everyone can access.
See also catalog, personal catalog, distributed catalog, and secured catalog.

signon
A User ID and password that is used to identify individual users and govern their access to
resources.

snapshot
A permanent local copy of the report and the data retrieved by a report. The data on your
personal computer can be shown and even manipulated at a later date without having to
connect it to the original database.

source catalog
A distributed catalog on the LAN that is maintained by the administrator. When users open a
distributed catalog, Impromptu makes a copy of the catalog on the user’s personal computer.
Impromptu maintains a link with the original source catalog so that if any changes are made to
the original, each user’s copy is updated automatically. Also called a master distributed catalog.

SQL (Structured Query Language)
The structured query language for accessing relational database information. You do not need
to know SQL to use Impromptu; Impromptu automatically generates the SQL needed to retrieve
the data for your report.

standard deviation
A measure of how much the data varies from the mean, expressed in the same units as the data
(for example, inches, seconds, days). The square root of the variance is standard deviation.
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Standard Toolbar
A bar with buttons and options you can use to create new reports, open existing reports, cut,
paste, and copy report objects, and perform many other routine commands while you work with
Impromptu reports.
See also toolbar and Toolbar button.

status line
A bar that appears at the bottom of the report window. The status line is a source of
context-sensitive help. The status line is continually updated to provide you with information as
you are working. It tells you what is happening, where you are, and what your options are. If your
pointer is over a Toolbar button or if you have highlighted a command, the status line tells you
what the command does.
The status line is divided into three sections:
• the catalog section shows which catalog is currently active.
• the report section shows report information such as progress indicators during saving,
retrieving, and printing. It also shows coordinates during drag and drop operations.
• the general section provides information about memory, keyboard toggles, and product
toggles (such as auto-retrieve).

stored procedure
A procedure defined and stored in a host database (such as Oracle or Sybase) that performs
actions on the database.

string
A character string enclosed in quotation marks. For example: "Cognos."

string_exp
A string constant, a string data item, or any expression resulting in a string value.

style
A defined group of formatting options that you can apply to selected report objects.

sub-report
A sub-report is a sub-query that is usually associated with a main query. You can include several
sub-reports in one report. With sub-reports, you can deliver information in one report that would
otherwise be available only with two or more reports.

summary
A summary component combined with a data item that has either fixed or automatic association.
The association of a summary determines the group for which it is calculated.
For example, if Total (Sales) is located in the Branch footer, then you will see the total sales for
each branch.
A summary can have either automatic association or fixed association with its location.
A summary with automatic association changes depending on its location. For example, if you
move Total (Sales) from the Branch footer to the Country footer, then you will see the total sales
for each country.
If a summary is explicitly associated, its value will reflect the group to which it is associated,
regardless of where you put it in the report. For example, if the summary Total (Sales) is
associated with the Country group and you place it in the City footer, then the summary will still
reflect the total sales for each country.
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summary filter
Limits the data retrieved in a report and can include summary components. A summary filter
eliminates data from a report based on summary data items. For example, you could create a
summary filter that eliminates all distributors with sales totaling less than $100,000. Data item
summary values are calculated after the summary filter is applied.
See also detail filter.

summary component
An operation that enables you to extract summary information from your data in the following
ways: total, minimum, maximum, average, count, rank, percentile, percentage, running-total,
running-minimum, running-maximum, running-average and running-count.

swap
Exchanges the positions of rows and columns in a crosstab report.

synonym
An alternative name for a table, view, alias, or another synonym. A synonym can be used in SQL
statements wherever a table or view is used. Use a synonym to substitute the value of the
synonym within the SQL.

syntax
Specific grammatical rules.

table
A portion of the database or HotFile that contains one kind of information organized into rows
and columns. In Impromptu, a table is a label for the item that points to the database table. A
catalog identifies the tables from the database that you want to access in Impromptu.

template
A template is a pattern you can use to build reports. By using templates, you can save time and
effort when you create new reports. If you create the same type of report frequently, the
template can be your guide.
A template can contain placeholders and store formatting information. You can specify
information about margin settings, page orientation, font choices for different report objects, and
so on.

text frame
A type of frame that contains text or data. Text frames are useful when creating blocks of static
text (as in form letters) or dynamic text based on data. All text in Impromptu reports is contained
in text frames. For example, whenever you see a data cell in a list frame, or a label in a summary
calculation, you are seeing a text frame.
See also child frame, parent frame, report object, and primary frame.

text object
An object that includes text.

thumbnail
A mode of operation you can set in Impromptu to create a temporary data file with a restricted
number of rows.

time_exp
A time constant, a time data item, or any expression resulting in a time value.

toolbar
A bar with buttons that perform commands.
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See also Standard Toolbar, Format Toolbar, and Layout Toolbar.

Toolbar button
A button that you click to perform an action. Buttons that perform related actions are grouped on
a toolbar.

type library
A collection of all exposed Impromptu objects, properties, and methods. The type library makes
it easier for programmers to use Impromptu automation components in their code.

user class
A group of users (or a single user) who need access to the same data in the catalog and who
have the same access privileges. For example, European salespeople all need data on their
customers who are in Europe, while North American salespeople need data on their customers
who are in North America.

user profile
All the information about a user class, such as the name of the user class, password, data
access privileges, and whether the user class can create reports.
See also user class.

variable
A value that is supplied by your computer or by Impromptu. Variables are inserted into reports
using the More Objects command from the Insert menu.

variance
The amount the individual data points differ from the average. This is calculated as the sum of
the square of the deviations from the mean, divided by one less than the number of
observations. For example,
variance =

e1+ e2+ e3
2

view
A definition stored in a database’s metadata that defines a ‘virtual table‘ that does not exist until
referenced in an SQL statement, such as a select statement.

Windows Common Logon Server
A server that records information about the users of a Windows-based application so that they
can log on once and access multiple data sources.

ymdinterval_exp
A year-month-day interval expression.
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